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WARNINGS, CAUTIONS AND NOTES

Warning! Warnings indicate conditions, which if not observed, can cause personal injury!

A

TRIAL PROTOCOLS

Caution! Cautions are included to help you avoid damaging hardware or losing data. e.qg.

There is a danger of a new battery exploding if it is incorrectly installed. Do not

A attempt to recharge, force open, or heat the battery. Replace the battery only
with the same or equivalent type recommended by the manufacturer. Discard
used batteries according to the manufacturer's instructions.

Note!  Notes provide optional additional information.

viii
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MODBUS/TCP

Introduction

Modbus is one of the most widely used serial communication protocol. It allows the transmis-
sion of information over serial lines between the switch and devices. The binding supports
both TCP and serial slaves.

The binding acts as Modbus TCP client (Modbus master), queering data from Modbus TCP
server (Modbus slaves).

STRIAL PROTOCOLS

Note! In the given example, the address offset 0x1000 (hex) equals Modbus address
-9 34097, while the address offset 0x1100 (hex) equals Modbus address 34353.
lé‘ The information given by Advantech is shown in hex mode.

Supported Modbus Object Types

The binding allows multiple Modbus slave connectivity. The following list includes the sup-
ported Modbus object types:

B coils, also known as digital out (DO) (read & write)

B discrete inputs, also known as digital in (DI) (read)

B input registers (read)

B holding registers (read & write)

The Modbus binding can be configured to interpret values stored in the 16bit registers, signed
or unsigned integers.

Read and Write Functions

Modbus specification has different operations for reading and writing different object types.
These types of operations are identified by function code. Some devices support only certain
function codes.

For different reading and writing operations, different objects types are available through Mod-
bus. The operations are designated by function codes.

B read coils: function code (FC) 1 (Read Caoils)

write coil: FC 5 (Write Single Coil)

read discrete inputs: FC 2 (Read Discrete Inputs)

read input registers: FC 4 (Read Input Registers)

read holding registers: FC 3 (Read Multiple Holding Registers)

write holding register: FC 6 (Write Single Holding Register), OR FC 16 (Write Multiple
Holding Registers)
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|TCP Modbus

The TCP Modbus function allows for client-server communication between a switch module
(server) and a device in the networking running MODBUS client software (client).

TRIAL PROTOCOLS

TCP Modbus Settings
The TCP Modbus Settings page allows you to configure the modbus function.
To access this page, click Management > TCP Modbus > TCP Modbus Settings.

£+ TCP Modbus Settings A
State (@ Disabled (O Enabled
Time out 3600 (1-86400)

Figure 1: Management > TCP Modbus > TCP Modbus Settings
The following table describes the items in the previous figure.

Table 1: Management > TCP Modbus > TCP Modbus Settings

Item Description

State Click Disabled or Enabled to set the TCP Modbus state.

Time out Enter the value (1 to 86400) to define the timeout period between transport
time.

Apply Click Apply to save the values and update the screen.

The ensuing table for TCP Modbus Status settings are informational only: TCP Modbus sta-
tus and TCP Modbus time out.

Masters or Slaves Designation

Modbus devices are classified as either a master or a slave. Initiating all communication with
the slave devices is tasked to the master device, while slave devices only respond to a com-
munication request.

Slaves ldentification

Modbus slave devices are assigned a unique ID between 1 and 247. When a request from the
master device is initiated, it must include the ID of the intended recipient. Master devices do
not have IDs.

Modbus/TCP Mapping

The data map addresses of Advantech switches shown in the following table start from Mod-
bus address 30001 for function code 4.

In the given example, the address offset 0x1000 (hex) equals Modbus address 34097, while
the address offset 0x1100 (hex) equals Modbus address 34353.

The information given by the table is shown in hex mode.
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STRIAL PROTOCOLS

| Modbus/TCP Mapping Table

The following listing displays parameters for referencing the different mapping functions.

Table 2: Modbus/TCP Mapping Table

Catelog

System Info

Name

Vendor ID =
0x13FE

Data Type

1 word |16 bits

Interpre Address Address "Description

tation

HEX

Offset
(Hex)

0x0000

3X

30001

Vendor ID = 0x13FE

Unit ID =
OxFF

1 word |16 bits

HEX

0x0001

30002

Unit ID = OxFF

Product
Code

1 word |16 bits

HEX

0x0002

30003

Product Code

Vendor
Name =
"Advan-
tech B+B
Smartworx"

16 words |32 chars

ASCII

0x0010

30017

Vendor Name = "Advan-
tech B+B Smartworx"
Word 0 Hi byte ="A’
Word 0 Lo byte ='d'
Word 1 Hi byte = 'v'
Word 1 Lo byte ="'a'
Word 2 Hi byte = 'n'
Word 2 Lo byte = 't'
Word 3 Hi byte ="'
Word 3 Lo byte ='c'
Word 4 Hi byte = 'h'
Word 4 Lo byte ="'
Word 5 Hi byte = 'B'
Word 5 Lo byte ="'+'
Word 6 Hi byte = 'B'
Word 6 Lo byte ="'
Word 7 Hi byte ='S'
Word 7 Lo byte ='m'
Word 8 Hi byte ="'a'
Word 8 Lo byte ='r'
Word 9 Hi byte ='t'
Word 9 Lo byte ="'w'
Word 10 Hi byte ="'0'
Word 10 Lo byte ='r'
Word 11 Hi byte = 'X'
Word 11 Lo byte ="\0'

Product
Name =
"SExxx"

16 words |32 chars

ASCII

0x0020

30033

Product Name = "SExxx"
Word 0 Hi byte ='S'
Word 0 Lo byte ='E'
Word 1 Hi byte = X'
Word 1 Lo byte ='x'
Word 2 Hi byte = 'x'
Word 2 Lo byte ="\0'

Firmware
Version

2 words |32 bits

HEX

0x020A

30523

Firmware Version

Word 0 Hi byte = major
Word 0 Lo byte = minor
Word 1 Hi byte = release
Word 1 Lo byte = build"
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation Offset 3X
(z29]
System Info|Ethernet |3 words |48 bits |HEX 0x020E |30527 |Ethernet MAC Address
MAC Ex: MAC = 00-19-CB-01-
Address 02-03

Word 0 Hi byte = 0x00
Word 0 Lo byte = 0x19
Word 1 Hi byte = 0xCB
Word 1 Lo byte = 0x01
Word 2 Hi byte = 0x02
Word 2 Lo byte = 0x03

Revision 16 words |32 chars [ASCIlI  |0x0211 |30530 |Product Name =
Number "YYY. xxxxx"

Word 0 Hi byte ="Y"
Word 0 Lo byte ='Y"
Word 1 Hi byte ="'Y"
Word 1 Lo byte ="'
Word 2 Hi byte = 'x'
Word 2 Lo byte = 'x'
Word 3 Hi byte = 'x'
Word 3 Lo byte = 'x'
Word 4 Hi byte = 'x'
Word 4 Hi byte ="\0'

IP Address |2 words |32 bits |HEX 0x0400 {31025 IP Address

Ex: IP =192.168.1.1
Word 0 Hi byte = 0xCO
Word 0 Lo byte = OxA8
Word 1 Hi byte = 0x01
Word 1 Lo byte = 0x01

Port Info Port Status |1 word |16 bits |HEX 0x1000~ |34097 ~ |Port Status
0x101F |34128 |0x0000: Link down
0x0001: Link up
OxFFFF: No port

Port 1 Sta- |1 word |16 bits |HEX 0x1000 |34097

tus
Port 2 Sta- {1 word |16 bits |HEX 0x1001 {34098
tus
Port 3 Sta- {1 word |16 bits |HEX 0x1002 |34099
tus
Port 4 Sta- {1 word |16 bits |HEX 0x1003 {34100
tus
Port 5 Sta- {1 word |16 bits |HEX 0x1004 |34101
tus
Port 6 Sta- {1 word |16 bits |HEX 0x1005 |34102
tus
Port 7 Sta- {1 word |16 bits |HEX 0x1006 |34103
tus
Port 8 Sta- {1 word |16 bits |HEX 0x1007 |34104
tus
Port 9 Sta- {1 word |16 bits |HEX 0x1008 |34105
tus
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)

Port Info Port 10 Sta-|1 word |16 bits |HEX 0x1009 |34106
tus
Port 11 Sta-|1 word |16 bits |HEX 0x100A |34107
tus
Port 12 Sta-|1 word |16 bits |HEX 0x100B |34108
tus
Port 13 Sta-|1 word |16 bits |HEX 0x100C |34109
tus
Port 14 Sta-|1 word |16 bits |HEX 0x100D |34110
tus
Port 15 Sta-|1 word |16 bits |HEX 0x100E |34111
tus
Port 16 Sta-|1 word |16 bits |HEX 0x100F |34112
tus
Port 17 Sta-|1 word |16 bits |HEX 0x1010 |34113
tus
Port 18 Sta-|1 word |16 bits |HEX 0x1011 |34114
tus
Port 19 Sta-|1 word |16 bits |HEX 0x1012 |34115
tus
Port 20 Sta-|1 word |16 bits |HEX 0x1013 |34116
tus
Port 21 Sta-|1 word |16 bits |HEX 0x1014 |34117
tus
Port 22 Sta-|1 word |16 bits |HEX 0x1015 |34118
tus
Port 23 Sta-|1 word |16 bits |HEX 0x1016 |34119
tus
Port 24 Sta-|1 word |16 bits |HEX 0x1017 |34120
tus
Port 25 Sta-|1 word |16 bits |HEX 0x1018 |34121
tus
Port 26 Sta-|1 word |16 bits |HEX 0x1019 |34122
tus
Port 27 Sta-|1 word |16 bits |HEX 0x101A |34123
tus
Port 28 Sta-|1 word |16 bits |HEX 0x101B |34124
tus
Port 29 Sta-|1 word |16 bits |HEX 0x101C |34125
tus
Port 30 Sta-|1 word |16 bits |HEX 0x101D |34126
tus
Port 31 Sta-|1 word |16 bits |HEX 0x101E |34127
tus
Port 32 Sta-|1 word |16 bits |HEX 0x101F |34128
tus
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)
Port Info Port Speed (1 word |16 bits |HEX 0x1100~ |34353 ~ |Port Speed
0x111F |34384 |0x0000: 10M-Half

0x0001: 10M-Full
0x0002: 100M-Half
0x0003: 100M-Full
0x0004: 1000M-Half
0x0005: 1000M-Full
OxFFFF: No port

Port 1 1word |16 bits |HEX 0x1100 |34353

Speed

Port 2 1word |16 bits [HEX 0x1101 |34354

Speed

Port 3 1word |16 bits |HEX 0x1102 |34355

Speed

Port 4 1word |16 bits [HEX 0x1103 |34356

Speed

Port 5 1word |16 bits |HEX 0x1104 |34357

Speed

Port 6 1word |16 bits [HEX 0x1105 |34358

Speed

Port 7 1word |16 bits |HEX 0x1106 |34359

Speed

Port 8 1word |16 bits [HEX 0x1107 |34360

Speed

Port 9 1word |16 bits |HEX 0x1108 |34361

Speed

Port 10 1word |16 bits [HEX 0x1109 |34362

Speed

Port 11 1word |16 bits [HEX Ox110A |34363

Speed

Port 12 1word |16 bits [HEX 0x110B |34364

Speed

Port 13 1word |16 bits |HEX 0x110C |34365

Speed

Port 14 1word |16 bits [HEX 0x110D |34366

Speed

Port 15 1word |16 bits |HEX 0x110E |34367

Speed

Port 16 1word |16 bits [HEX 0x110F |34368

Speed

Port 17 1word |16 bits [HEX 0x1110 |34369

Speed

Port 18 1word |16 bits [HEX 0x1111 34370

Speed

Port 19 1word |16 bits |HEX 0x1112 |34371

Speed

Port 20 1word |16 bits [HEX 0x1113 |34372

Speed
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)

Port Info Port 21 1word |16 bits |HEX 0x1114 |34373
Speed
Port 22 1word |16 bits |HEX 0x1115 |34374
Speed
Port 23 1word |16 bits |HEX 0x1116 |34375
Speed
Port 24 1word |16 bits |HEX 0x1117 |34376
Speed
Port 25 1word |16 bits |HEX 0x1118 |34377
Speed
Port 26 1word |16 bits |HEX 0x1119 |34378
Speed
Port 27 1word |16 bits |HEX 0x111A |34379
Speed
Port 28 1word |16 bits |HEX 0x111B 34380
Speed
Port 29 1word |16 bits |HEX 0x111C |34381
Speed
Port 30 1word |16 bits |HEX 0x111D |34382
Speed
Port 31 1word |16 bits |HEX 0x111E |34383
Speed
Port 32 1word |16 bits |HEX 0x111F |34384
Speed
Flow Con- |1word |16 bits |HEX 0x1200~ |34609 ~ |Flow Control
trol 0x121F |34640 |0x0000: Off

0x0001: On
OxFFFF: No port

Port 1 Flow {1 word |16 bits |HEX 0x1200 |34609

Control
Port 2 Flow |1 word |16 bits |HEX 0x1201 |34610
Control
Port 3 Flow {1 word |16 bits |HEX 0x1202 |34611
Control
Port4 Flow |1 word |16 bits |HEX 0x1203 |34612
Control
Port 5 Flow {1 word |16 bits |HEX 0x1204 |34613
Control
Port 6 Flow |1 word |16 bits |HEX 0x1205 |34614
Control
Port 7 Flow |1 word |16 bits |HEX 0x1206 |34615
Control
Port 8 Flow |1 word |16 bits |HEX 0x1207 |34616
Control
Port 9 Flow {1 word |16 bits |HEX 0x1208 |34617
Control
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description
tation  Offset 3X
(z[229)
Port Info Port 10 1word |16 bits [HEX 0x1209 |34618
Flow Con-

trol
Port 11 1word |16 bits |HEX 0x120A |34619
Flow Con-
trol
Port 12 1word |16 bits |HEX 0x120B |34620
Flow Con-
trol
Port 13 1word |16 bits |HEX 0x120C |34621
Flow Con-
trol
Port 14 1word |16 bits |HEX 0x120D |34622
Flow Con-
trol
Port 15 1word |16 bits |HEX 0x120E |34623
Flow Con-
trol
Port 16 1word |16 bits |HEX 0x120F |34624
Flow Con-
trol
Port 17 1word |16 bits |HEX 0x1210 |34625
Flow Con-
trol
Port 18 1word |16 bits |HEX 0x1211 |34626
Flow Con-
trol
Port 19 1word |16 bits |HEX 0x1212 |34627
Flow Con-
trol
Port 20 1word |16 bits |HEX 0x1213 |34628
Flow Con-
trol
Port 21 1word |16 bits |HEX 0x1214 |34629
Flow Con-
trol
Port 22 1word |16 bits |HEX 0x1215 |34630
Flow Con-
trol
Port 23 1word |16 bits |HEX 0x1216 |34631
Flow Con-
trol
Port 24 1word |16 bits |HEX 0x1217 |34632
Flow Con-
trol
Port 25 1word |16 bits |HEX 0x1218 |34633
Flow Con-
trol
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description
tation  Offset 3X
(z[229)
Port Info Port 26 1word |16 bits [HEX 0x1219 |34634
Flow Con-

trol

Port 27 1word |16 bits |HEX 0x121A |34635
Flow Con-
trol

Port 28 1word |16 bits |HEX 0x121B |34636
Flow Con-
trol

Port 29 1word |16 bits |HEX 0x121C |34637
Flow Con-
trol

Port 30 1word |16 bits |HEX 0x121D |34638
Flow Con-
trol

Port 31 1word |16 bits |HEX 0x121E |34639
Flow Con-
trol

Port 32 1word |16 bits |HEX 0x121F |34640

Flow Con-

trol

Port 20 words |40 chars |ASCIl  |0x1400~|35121 ~ |Port Description

Description 0x166C |35741 Port Description =
"100RX,RJ45."
Word 0 Hi byte ='1"
Word 0 Lo byte ='0'
Word 1Hi byte ='0'
Word 1 Lo byte = ‘R’
Word 2 Hi byte = 'X'
Word 2 Lo byte =
Word 3 Hi byte = 'R’
Word 3 Lo byte =*J’
Word 4 Hi byte = ‘4’
Word 4 Lo byte = ‘5’
Word 5 Hi byte =’
Word 5 Lo byte = \0’

Port 1 20 words |40 chars |ASCII  |0x1400 |35121

Description

Port 2 20 words |40 chars |ASCIl  |0x1414 |35141

Description

Port 3 20 words |40 chars |ASCIl  |0x1428 |35161

Description

Port 4 20 words |40 chars |ASCIl  |0x143C |35181

Description

Port 5 20 words |40 chars |ASCII  |0x1450 |35201

Description

Port 6 20 words |40 chars |ASCIl  |0x1464 |35221

Description
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation Offset 3X
(Hex)

Port Info Port 7 20 words |40 chars |[ASCIl  |0x1478 |35241
Description
Port 8 20 words |40 chars [ASCIlI  |0x148C |35261
Description
Port 9 20 words |40 chars |[ASCIl  |0x14A0 |35281
Description
Port 10 20 words |40 chars [ASCIl  |0x14B4 |35301
Description
Port 11 20 words |40 chars |[ASCIl |0x14C8 |35321
Description
Port 12 20 words |40 chars |ASCIl  [0x14DC |35341
Description
Port 13 20 words |40 chars |[ASCIl  |0x14F0 |35361
Description
Port 14 20 words |40 chars |ASCIl  [0x1504 |35381
Description
Port 15 20 words |40 chars |[ASCIl  |0x1518 |35401
Description
Port 16 20 words |40 chars [ASCIlI  |0x152C |35421
Description
Port 17 20 words |40 chars [ASCIl  |0x1540 |35441
Description
Port 18 20 words |40 chars |ASCIl  |0x1554 |35461
Description
Port 19 20 words |40 chars |[ASCIl |0x1568 |35481
Description
Port 20 20 words |40 chars [ASCIl  |0x157C |35501
Description
Port 21 20 words |40 chars |[ASCIl  |0x1590 |35521
Description
Port 22 20 words |40 chars |ASCIl  [0x15A4 |35541
Description
Port 23 20 words |40 chars |[ASCIl |0x15B8 |35561
Description
Port 24 20 words |40 chars [ASCIl  |0x15CC |35581
Description
Port 25 20 words |40 chars |[ASCIl  |0x15E0 |35601
Description
Port 26 20 words |40 chars [ASCIl  |0x15F4 |35621
Description
Port 27 20 words |40 chars |[ASCIl |0x1608 |35641
Description
Port 28 20 words |40 chars |ASCII  [0x161C |35661
Description
Port 29 20 words |40 chars |[ASCIl  |0x1630 |35681
Description

10
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)
Port Info Port 30 20 words |40 chars |ASCIl  |0x1644 |35701

Description

Port 31 20 words |40 chars |ASCII  |0x1658 |35721

Description

Port 32 20 words |40 chars |ASCII  |0x166C |35741

Description

Link Up 1word |16 bits [HEX 0x1700~ {35889 ~ |Link Up Counter

Counter Ox171F |35920 |Ex: port link up counter =
13
Received MODBUS
response: 0x000D

Port 1 Link |1 word |16 bits |HEX 0x1700 |35889

Up Counter

Port 2 Link {1 word |16 bits |HEX 0x1701 {35890

Up Counter

Port 3 Link |1 word |16 bits |HEX 0x1702 |35891

Up Counter

Port 4 Link {1 word |16 bits |HEX 0x1703 |35892

Up Counter

Port 5Link |1 word |16 bits |HEX 0x1704 |35893

Up Counter

Port 6 Link {1 word |16 bits |HEX 0x1705 |35894

Up Counter

Port 7 Link |1 word |16 bits |HEX 0x1706 |35895

Up Counter

Port 8 Link {1 word |16 bits |HEX 0x1707 |35896

Up Counter

Port9 Link |1 word |16 bits |HEX 0x1708 |35897

Up Counter

Port 10 1word |16 bits [HEX 0x1709 |35898

Link Up

Counter

Port 11 Link |1 word |16 bits |HEX 0x170A |35899

Up Counter

Port 12 1word |16 bits [HEX 0x170B {35900

Link Up

Counter

Port 13 1word |16 bits [HEX 0x170C |35901

Link Up

Counter

Port 14 1word |16 bits [HEX 0x170D |35902

Link Up

Counter

Port 15 1word |16 bits [HEX 0x170E |35903

Link Up

Counter

11
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description

tation Offset 3X
(Hex)

Port Info Port 16 1word |16 bits |HEX 0x170F |35904
Link Up
Counter
Port 17 1word |16 bits |HEX 0x1710 |35905
Link Up
Counter
Port 18 1word |16 bits |HEX 0x1711 |35906
Link Up
Counter
Port 19 1word |16 bits |[HEX 0x1712 |35907
Link Up
Counter
Port 20 1word |16 bits |HEX 0x1713 |35908
Link Up
Counter
Port 21 1word |16 bits |[HEX 0x1714 |35909
Link Up
Counter
Port 22 1word |16 bits |HEX 0x1715 |35910
Link Up
Counter
Port 23 1word |16 bits |[HEX 0x1716 |35911
Link Up
Counter
Port 24 1word |16 bits |HEX 0x1717 |35912
Link Up
Counter
Port 25 1word |16 bits |HEX 0x1718 |35913
Link Up
Counter
Port 26 1word |16 bits |HEX 0x1719 |35914
Link Up
Counter
Port 27 1word |16 bits |[HEX 0x171A |35915
Link Up
Counter
Port 28 1word |16 bits |HEX 0x171B |35916
Link Up
Counter
Port 29 1word |16 bits |[HEX 0x171C |35917
Link Up
Counter
Port 30 1word |16 bits |HEX 0x171D |35918
Link Up
Counter
Port 31 1word |16 bits |[HEX 0x171E |35919
Link Up
Counter

12
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)

Port Info Port 32 1word |16 bits [HEX 0x171F |35920
Link Up
Counter
PoE Volt- |1word |16 bits |HEX 0x1800~ |36145 ~ |PoE Voltage (V)
age 0x181F |36176 |Ex: poe voltage = 5

Received MODBUS
response: 0x0005

Port 1 PoE |1 word |16 bits |HEX 0x1800 |36145
Voltage
Port 2 PoE |1 word |16 bits |HEX 0x1801 |36146
Voltage
Port 3 PoE |1 word |16 bits |HEX 0x1802 |36147
Voltage
Port 4 PoE {1 word |16 bits |HEX 0x1803 |36148
Voltage
Port 5 PoE |1 word |16 bits |HEX 0x1804 |36149
Voltage
Port 6 PoE |1 word |16 bits |HEX 0x1805 |36150
Voltage
Port 7 PoE |1 word |16 bits |HEX 0x1806 |36151
Voltage
Port 8 PoE |1 word |16 bits |HEX 0x1807 |36152
Voltage
Port 9 PoE |1 word |16 bits |HEX 0x1808 |36153
Voltage
Port 10 1word |16 bits |HEX 0x1809 |36154
PoE Volt-
age
Port 11 PoE |1 word |16 bits |HEX 0x180A |36155
Voltage
Port 12 1word |16 bits [HEX 0x180B |36156
PoE Volt-
age
Port 13 1word |16 bits [HEX 0x180C |36157
PoE Volt-
age
Port 14 1word |16 bits [HEX 0x180D |36158
PoE Volt-
age
Port 15 1word |16 bits [HEX 0x180E |36159
PoE Volt-
age
Port 16 1word |16 bits |HEX 0x180F |36160
PoE Volt-
age
Port 17 1word |16 bits [HEX 0x1810 |36161
PoE Volt-
age

13
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description

tation Offset 3X
(Hex)

Port Info Port 18 1word |16 bits |HEX 0x1811 |36162
PoE Volt-
age

Port 19 1word |16 bits |HEX 0x1812 |36163
PoE Volt-
age
Port 20 1word |16 bits |HEX 0x1813 |36164
PoE Volt-
age
Port 21 1word |16 bits |HEX 0x1814 |36165
PoE Volt-
age
Port 22 1word |16 bits |HEX 0x1815 |36166
PoE Volt-
age
Port 23 1word |16 bits |HEX 0x1816 |36167
PoE Volt-
age
Port 24 1word |16 bits |HEX 0x1817 |36168
PoE Volt-
age
Port 25 1word |16 bits |HEX 0x1818 |36169
PoE Volt-
age
Port 26 1word |16 bits |HEX 0x1819 |36170
PoE Volt-
age
Port 27 1word |16 bits |HEX Ox181A |36171
PoE Volt-
age
Port 28 1word |16 bits |HEX 0x181B |36172
PoE Volt-
age
Port 29 1word |16 bits |HEX 0x181C |36173
PoE Volt-
age
Port 30 1word |16 bits |HEX 0x181D |36174
PoE Volt-
age
Port 31 1word |16 bits |HEX Ox181E |36175
PoE Volt-
age
Port 32 1word |16 bits |HEX 0x181F |36176
PoE Volt-
age

14
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)
Port Info PoE Cur- |1word |16 bits |HEX 0x1820~ (36177 ~ |PoE Current (mA)
rent 0x183F |36208 Ex: poe current = 13
Received MODBUS
response: 0x000D
Port 1 PoE |1 word |16 bits |HEX 0x1820 |36177
Current
Port 2 PoE |1 word |16 bits |HEX 0x1821 |36178
Current
Port 3 PoE |1 word |16 bits |HEX 0x1822 |36179
Current
Port 4 PoE |1 word |16 bits |HEX 0x1823 |36180
Current
Port 5 PoE |1 word |16 bits |HEX 0x1824 |36181
Current
Port 6 PoE |1 word |16 bits |HEX 0x1825 |36182
Current
Port 7 PoE |1 word |16 bits |HEX 0x1826 |36183
Current
Port 8 PoE |1 word |16 bits |HEX 0x1827 |36184
Current
Port 9 PoE |1 word |16 bits |HEX 0x1828 |36185
Current
Port 10 1word |16 bits |HEX 0x1829 |36186
PoE Cur-
rent
Port 11 PoE |1 word |16 bits |HEX 0x182A |36187
Current
Port 12 1word |16 bits |HEX 0x182B |36188
PoE Cur-
rent
Port 13 1word |16 bits |[HEX 0x182C |36189
PoE Cur-
rent
Port 14 1word |16 bits |HEX 0x182D |36190
PoE Cur-
rent
Port 15 1word |16 bits |[HEX 0x182E |36191
PoE Cur-
rent
Port 16 1word |16 bits |HEX 0x182F |36192
PoE Cur-
rent
Port 17 1word |16 bits |[HEX 0x1830 |36193
PoE Cur-
rent
Port 18 1word |16 bits |HEX 0x1831 |36194
PoE Cur-
rent

15
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description

tation Offset 3X
(Hex)

Port Info Port 19 1word |16 bits |HEX 0x1832 |36195
PoE Cur-
rent

Port 20 1word |16 bits |HEX 0x1833 |36196
PoE Cur-
rent

Port 21 1word |16 bits |HEX 0x1834 |36197

PoE Cur-
rent

Port 22 1word |16 bits |HEX 0x1835 |36198
PoE Cur-
rent

Port 23 1word |16 bits |HEX 0x1836 |36199

PoE Cur-
rent

Port 24 1word |16 bits |HEX 0x1837 |36200
PoE Cur-
rent

Port 25 1word |16 bits [HEX 0x1838 |36201

PoE Cur-
rent

Port 26 1word |16 bits |HEX 0x1839 |36202
PoE Cur-
rent

Port 27 1word |16 bits |HEX 0x183A |36203

PoE Cur-
rent

Port 28 1word |16 bits |HEX 0x183B |36204
PoE Cur-
rent

Port 29 1word |16 bits |HEX 0x183C |36205

PoE Cur-
rent

Port 30 1word |16 bits |HEX 0x183D |36206
PoE Cur-
rent

Port 31 1word |16 bits |HEX 0x183E |36207

PoE Cur-
rent

Port 32 1word |16 bits [HEX 0x183F |36208
PoE Cur-
rent

PoE Power {1 word |16 bits |HEX 0x1840~ (36209 ~ |PoE Power (W)
0x185F |36240 Ex: poe power = 10
Received MODBUS
response: 0x000A

Port 1 PoE {1 word |16 bits [|HEX 0x1840 |36209
Power

16
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)

Port Info Port 2 PoE |1 word 16 bits HEX 0x1841 |36210
Power
Port 3 PoE |1 word |16 bits |HEX 0x1842 |36211
Power
Port 4 PoE |1 word |16 bits |HEX 0x1843 |36212
Power
Port 5 PoE |1 word |16 bits |HEX 0x1844 |36213
Power
Port 6 PoE |1 word |16 bits |HEX 0x1845 |36214
Power
Port 7 PoE |1 word |16 bits |[HEX 0x1846 |36215
Power
Port 8 PoE |1 word |16 bits |HEX 0x1847 |36216
Power
Port 9 PoE |1 word |16 bits |HEX 0x1848 |36217
Power
Port 10 1word |16 bits |HEX 0x1849 |36218
PoE Power
Port11 PoE |1 word |16 bits |HEX 0x184A |36219
Power
Port 12 1word |16 bits |HEX 0x184B |36220
PoE Power
Port 13 1word |16 bits |HEX 0x184C |36221
PoE Power
Port 14 1word |16 bits |HEX 0x184D |36222
PoE Power
Port 15 1word |16 bits |HEX 0x184E |36223
PoE Power
Port 16 1word |16 bits |HEX 0x184F |36224
PoE Power
Port 17 1word |16 bits |HEX 0x1850 |36225
PoE Power
Port 18 1word |16 bits |HEX 0x1851 |36226
PoE Power
Port 19 1word |16 bits |HEX 0x1852 |36227
PoE Power
Port 20 1word |16 bits |HEX 0x1853 |36228
PoE Power
Port 21 1word |16 bits |HEX 0x1854 |36229
PoE Power
Port 22 1word |16 bits |HEX 0x1855 |36230
PoE Power
Port 23 1word |16 bits |HEX 0x1856 |36231
PoE Power
Port 24 1word |16 bits |HEX 0x1857 |36232
PoE Power

17
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)

Port Info Port 25 1word |16 bits [HEX 0x1858 |36233
PoE Power
Port 26 1word |16 bits [HEX 0x1859 |36234
PoE Power
Port 27 1word |16 bits [HEX 0x185A |36235
PoE Power
Port 28 1word |16 bits [HEX 0x185B |36236
PoE Power
Port 29 1word |16 bits [HEX 0x185C |36237
PoE Power
Port 30 1word |16 bits [HEX 0x185D |36238
PoE Power
Port 31 1word |16 bits [HEX 0x185E |36239
PoE Power
Port 32 1word |16 bits [HEX 0x185F |36240
PoE Power
PoE Tem- |1word |16 bits |HEX 0x1860~ |36241 ~ |PoE Temperature (C)
perature 0x187F |36272 Ex: poe temperature = 32

Received MODBUS
response: 0x0020

Port 1 PoE {1 word |16 bits |HEX 0x1860 |36241
Tempera-
ture
Port 2 PoE {1 word |16 bits |HEX 0x1861 |36242
Tempera-
ture
Port 3 PoE {1 word |16 bits |HEX 0x1862 |36243
Tempera-
ture
Port 4 PoE {1 word |16 bits |HEX 0x1863 |36244
Tempera-
ture
Port 5 PoE {1 word |16 bits |HEX 0x1864 |36245
Tempera-
ture
Port 6 PoE {1 word |16 bits |HEX 0x1865 |36246
Tempera-
ture
Port 7 PoE {1 word |16 bits |HEX 0x1866 |36247
Tempera-
ture
Port 8 POoE {1 word |16 bits |HEX 0x1867 |36248
Tempera-
ture
Port 9 PoE {1 word |16 bits |HEX 0x1868 |36249
Tempera-
ture

18
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description

tation Offset 3X
(Hex)

Port Info Port 10 1word |16 bits [HEX 0x1869 |36250
PoE Tem-
perature

Port11 PoE {1 word |16 bits |HEX 0x186A |36251
Tempera-
ture

Port 12 1word |16 bits [HEX 0x186B |36252
PoE Tem-
perature
Port 13 1word |16 bits [HEX 0x186C |36253
PoE Tem-
perature
Port 14 1word |16 bits [HEX 0x186D |36254
PoE Tem-
perature
Port 15 1word |16 bits [HEX 0x186E |36255
PoE Tem-
perature
Port 16 1word |16 bits [HEX 0x186F |36256
PoE Tem-
perature
Port 17 1word |16 bits [HEX 0x1870 |36257
PoE Tem-
perature
Port 18 1word |16 bits [HEX 0x1871 |36258
PoE Tem-
perature
Port 19 1word |16 bits [HEX 0x1872 |36259
PoE Tem-
perature
Port 20 1word |16 bits [HEX 0x1873 |36260
PoE Tem-
perature
Port 21 1word |16 bits [HEX 0x1874 |36261
PoE Tem-
perature
Port 22 1word |16 bits [HEX 0x1875 |36262
PoE Tem-
perature
Port 23 1word |16 bits [HEX 0x1876 |36263
PoE Tem-
perature
Port 24 1word |16 bits [HEX 0x1877 |36264
PoE Tem-
perature
Port 25 1word |16 bits [HEX 0x1878 |36265
PoE Tem-
perature

19



BB SMARTWORX

DAl AD\ANTECH

Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)
Port Info Port 26 1word |16 bits [HEX 0x1879 |36266
PoE Tem-
perature
Port 27 1word |16 bits [HEX 0x187A |36267
PoE Tem-
perature
Port 28 1word |16 bits [HEX 0x187B |36268
PoE Tem-
perature
Port 29 1word |16 bits [HEX 0x187C |36269
PoE Tem-
perature
Port 30 1word |16 bits [HEX 0x187D |36270
PoE Tem-
perature
Port 31 1word |16 bits [HEX 0x187E |36271
PoE Tem-
perature
Port 32 1word |16 bits [HEX 0x187F |36272
PoE Tem-
perature
Packet Info [Tx Packets |4 words |64 bits |HEX 0x2000~|38193 ~ | Tx Packets
Counter 0x207C |38317 |Ex: port 1 Tx Packet

Amount = 11223344
Received MODBUS
response: 0xAB4130
Word 0 = 0x0000
Word 1 = 0x0000
Word 2 = 0x00AB
Word 3 = 0x4130

Port1 Tx |4 words |64 bits |HEX 0x2000 |38193

Packets
Port2 Tx |4 words |64 bits |HEX 0x2004 |38197
Packets
Port 3 Tx |4 words |64 bits |HEX 0x2008 |38201
Packets
Port4 Tx |4 words |64 bits |HEX 0x200C |38205
Packets
Port 5 Tx |4 words |64 bits |HEX 0x2010 {38209
Packets
Port6 Tx |4 words |64 bits |HEX 0x2014 |38213
Packets
Port 7 Tx |4 words |64 bits |HEX 0x2018 |38217
Packets
Port 8 Tx |4 words |64 bits |HEX 0x201C |38221
Packets
Port 9 Tx |4 words |64 bits |HEX 0x2020 |38225
Packets
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)

Packet Info |Port 10 Tx |4 words |64 bits HEX 0x2024 38229
Packets
Port 11 Tx |4 words |64 bits |HEX 0x2028 |38233
Packets
Port 12 Tx |4 words (64 bits |HEX 0x202C |38237
Packets
Port 13 Tx |4 words |64 bits |HEX 0x2030 |38241
Packets
Port 14 Tx |4 words |64 bits |HEX 0x2034 |38245
Packets
Port 15 Tx |4 words |64 bits |HEX 0x2038 |38249
Packets
Port 16 Tx |4 words |64 bits |HEX 0x203C |38253
Packets
Port 17 Tx |4 words |64 bits |HEX 0x2040 |38257
Packets
Port 18 Tx |4 words |64 bits |HEX 0x2044 |38261
Packets
Port 19 Tx |4 words |64 bits |HEX 0x2048 |38265
Packets
Port 20 Tx |4 words |64 bits |HEX 0x204C |38269
Packets
Port 21 Tx |4 words |64 bits |HEX 0x2050 |38273
Packets
Port 22 Tx |4 words |64 bits |HEX 0x2054 |38277
Packets
Port 23 Tx |4 words |64 bits |HEX 0x2058 |38281
Packets
Port 24 Tx |4 words |64 bits |HEX 0x205C |38285
Packets
Port 25 Tx |4 words |64 bits |HEX 0x2060 |38289
Packets
Port 26 Tx |4 words (64 bits |HEX 0x2064 |38293
Packets
Port 27 Tx |4 words |64 bits |[HEX 0x2068 |38297
Packets
Port 28 Tx |4 words (64 bits |HEX 0x206C |38301
Packets
Port 29 Tx |4 words |64 bits |HEX 0x2070 |38305
Packets
Port 30 Tx |4 words (64 bits |HEX 0x2074 |38309
Packets
Port 31 Tx |4 words |64 bits |HEX 0x2078 |38313
Packets
Port 32 Tx |4 words |64 bits |HEX 0x207C |38317
Packets
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)
Packet Info |Rx Packets |4 words |64 bits HEX 0x2100~ (38449 ~ |Rx Packets

Counter 0x217C |38573 |Ex: port 1 Rx Packet
Amount = 11223344
Received MODBUS
response: 0xAB4130
Word 0 = 0x0000
Word 1 = 0x0000
Word 2 = 0x00AB
Word 3 = 0x4130

Port 1 Rx |4 words |64 bits [|HEX 0x2100 |38449

Packets

Port2 Rx |4 words |64 bits |HEX 0x2104 |38453

Packets

Port 3Rx |4 words (64 bits |HEX 0x2108 |38457

Packets

Port4 Rx |4 words |64 bits |HEX 0x210C |38461

Packets

Port 5Rx |4 words |64 bits [|HEX 0x2110 |38465

Packets

Port 6 Rx |4 words |64 bits |HEX 0x2114 |38469

Packets

Port 7 Rx |4 words |64 bits |HEX 0x2118 (38473

Packets

Port 8 Rx |4 words (64 bits |HEX 0x211C |38477

Packets

Port 9 Rx |4 words (64 bits |HEX 0x2120 |38481

Packets

Port 10 Rx |4 words (64 bits |HEX 0x2124 |38485

Packets

Port 11 Rx |4 words |64 bits [|HEX 0x2128 |38489

Packets

Port 12 Rx |4 words (64 bits |HEX 0x212C |38493

Packets

Port 13 Rx |4 words |64 bits [|HEX 0x2130 |38497

Packets

Port 14 Rx |4 words (64 bits |HEX 0x2134 |38501

Packets

Port 15 Rx |4 words (64 bits |HEX 0x2138 |38505

Packets

Port 16 Rx |4 words (64 bits |HEX 0x213C |38509

Packets

Port 17 Rx |4 words |64 bits [|HEX 0x2140 |38513

Packets

Port 18 Rx |4 words |64 bits |HEX 0x2144 |38517

Packets

Port 19 Rx |4 words |64 bits |HEX 0x2148 |38521

Packets
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog NETNE Data Type Interpre Address Address "Description
tation  Offset 3X
(Hex)
Packet Info |Port 20 Rx |4 words (64 bits |HEX 0x214C |38525

Packets

Port 21 Rx |4 words |64 bits |[HEX 0x2150 |38529

Packets

Port 22 Rx |4 words (64 bits |HEX 0x2154 |38533

Packets

Port 23 Rx |4 words |64 bits |HEX 0x2158 |38537

Packets

Port 24 Rx |4 words |64 bits |HEX 0x215C |38541

Packets

Port 25 Rx |4 words |64 bits |HEX 0x2160 |38545

Packets

Port 26 Rx |4 words (64 bits |HEX 0x2164 |38549

Packets

Port 27 Rx |4 words |64 bits |HEX 0x2168 |38553

Packets

Port 28 Rx |4 words |64 bits |HEX 0x216C |38557

Packets

Port 29 Rx |4 words |64 bits |[HEX 0x2170 |38561

Packets

Port 30 Rx |4 words (64 bits |HEX 0x2174 |38565

Packets

Port 31 Rx |4 words |64 bits |HEX 0x2178 |38569

Packets

Port 32 Rx |4 words |64 bits |HEX 0x217C |38573

Packets

Tx Error 2 words |32 bits [HEX 0x2200~|38705 ~ |Tx Error Packets

Packets 0x223E |38767 |Ex: port 1 Tx Packet

Counter Amount = 11223344
Received MODBUS
response: 0xAB4130
Word 0 = 0x00AB
Word 1 = 0x4130

Port1 Tx |2 words (32 bits |HEX 0x2200 |38705

Error Pack-

ets

Port2 Tx |2 words |32 bits |HEX 0x2202 |38707

Error Pack-

ets

Port 3 Tx |2words (32 bits |HEX 0x2204 |38709

Error Pack-

ets

Port4 Tx |2 words |32 bits |HEX 0x2206 |38711

Error Pack-

ets

Port 5 Tx |2words (32 bits |HEX 0x2208 |38713

Error Pack-

ets
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description
tation  Offset 3X

(Hex)

Packet Info |Port 6 Tx |2 words |32 bits HEX 0x220A |38715
Error Pack-
ets

Port 7 Tx |2 words |32 bits [|HEX 0x220C |38717
Error Pack-
ets
Port 8 Tx |2 words (32 bits |HEX 0x220E |38719
Error Pack-
ets
Port 9 Tx |2 words |32 bits |[HEX 0x2210 |38721
Error Pack-
ets
Port 10 Tx |2 words |32 bits |HEX 0x2212 |38723
Error Pack-
ets
Port 11 Tx |2 words |32 bits |HEX 0x2214 38725
Error Pack-
ets
Port 12 Tx |2 words |32 bits |HEX 0x2216 |38727
Error Pack-
ets
Port 13 Tx |2 words |32 bits |HEX 0x2218 |38729
Error Pack-
ets
Port 14 Tx |2 words |32 bits |HEX 0x221A |38731
Error Pack-
ets
Port 15 Tx |2 words |32 bits |HEX 0x221C |38733
Error Pack-
ets
Port 16 Tx |2 words |32 bits |HEX 0x221E |38735
Error Pack-
ets
Port 17 Tx |2 words |32 bits |HEX 0x2220 |38737
Error Pack-
ets
Port 18 Tx |2 words |32 bits |HEX 0x2222 |38739
Error Pack-
ets
Port 19 Tx |2 words |32 bits |HEX 0x2224 |38741
Error Pack-
ets
Port 20 Tx |2 words |32 bits |HEX 0x2226 |38743
Error Pack-
ets
Port 21 Tx |2 words |32 bits |HEX 0x2228 |38745
Error Pack-
ets
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description

tation Offset 3X
(Hex)

Packet Info |Port 22 Tx |2 words |32 bits HEX 0x222A |38747
Error Pack-
ets

Port 23 Tx |2 words (32 bits |HEX 0x222C |38749
Error Pack-
ets

Port 24 Tx |2 words |32 bits |HEX 0x222E |38751
Error Pack-
ets

Port 25 Tx |2 words |32 bits |HEX 0x2230 |38753
Error Pack-
ets

Port 26 Tx |2 words |32 bits |HEX 0x2232 |38755
Error Pack-
ets

Port 27 Tx |2 words |32 bits |HEX 0x2234 |38757
Error Pack-
ets

Port 28 Tx |2 words |32 bits |HEX 0x2236 |38759
Error Pack-
ets

Port 29 Tx |2 words |32 bits |HEX 0x2238 |38761
Error Pack-
ets

Port 30 Tx |2 words |32 bits |HEX 0x223A |38763
Error Pack-
ets

Port 31 Tx |2 words |32 bits |HEX 0x223C |38765
Error Pack-
ets

Port 32 Tx |2 words |32 bits |HEX 0x223E |38767
Error Pack-
ets

Rx Error 2 words |32 bits |HEX 0x2300~|38961 ~ |Rx Error Packets
Packets 0x233E |39023 |Ex: port 1 Rx Packet
Counter Amount = 11223344
Received MODBUS
response: 0xAB4130
Word 0 = Ox00AB
Word 1 = 0x4130

Port1 Rx |2 words (32 bits |HEX 0x2300 |38961
Error Pack-
ets
Port 2 Rx |2 words |32 bits |HEX 0x2302 |38963
Error Pack-
ets
Port 3Rx |2 words (32 bits |HEX 0x2304 |38965
Error Pack-
ets
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description

tation Offset 3X
(Hex)

Packet Info |Port4 Rx |2 words |32 bits HEX 0x2306 |38967
Error Pack-
ets

Port 5Rx |2 words (32 bits |HEX 0x2308 |38969
Error Pack-
ets
Port 6 Rx |2 words (32 bits |HEX 0x230A |38971
Error Pack-
ets
Port 7 Rx |2 words |32 bits |HEX 0x230C |38973
Error Pack-
ets
Port 8 Rx |2 words (32 bits |HEX 0x230E |38975
Error Pack-
ets
Port 9 Rx |2 words |32 bits |HEX 0x2310 |38977
Error Pack-
ets
Port 10 Rx |2 words |32 bits |HEX 0x2312 |38979
Error Pack-
ets
Port 11 Rx |2 words |32 bits |HEX 0x2314 |38981
Error Pack-
ets
Port 12 Rx |2 words |32 bits |HEX 0x2316 |38983
Error Pack-
ets
Port 13 Rx |2 words |32 bits |HEX 0x2318 |38985
Error Pack-
ets
Port 14 Rx |2 words |32 bits |HEX 0x231A |38987
Error Pack-
ets
Port 15 Rx |2 words |32 bits |HEX 0x231C |38989
Error Pack-
ets
Port 16 Rx |2 words |32 bits |HEX 0x231E |38991
Error Pack-
ets
Port 17 Rx |2 words |32 bits |HEX 0x2320 |38993
Error Pack-
ets
Port 18 Rx |2 words |32 bits |HEX 0x2322 |38995
Error Pack-
ets
Port 19 Rx |2 words |32 bits |HEX 0x2324 |38997
Error Pack-
ets
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Table 2: Modbus/TCP Mapping Table (Continued)

STRIAL PROTOCOLS

Catelog INETg] Data Type Interpre Address Address "Description

tation Offset 3X
(Hex)

Packet Info |Port 20 Rx |2 words |32 bits HEX 0x2326 |38999
Error Pack-
ets

Port 21 Rx |2 words |32 bits |HEX 0x2328 |39001
Error Pack-
ets
Port 22 Rx |2 words |32 bits |HEX 0x232A |39003
Error Pack-
ets
Port 23 Rx |2 words |32 bits |HEX 0x232C |39005
Error Pack-
ets
Port 24 Rx |2 words |32 bits |HEX 0x232E |39007
Error Pack-
ets
Port 25 Rx |2 words |32 bits |HEX 0x2330 |39009
Error Pack-
ets
Port 26 Rx |2 words |32 bits |HEX 0x2332 |39011
Error Pack-
ets
Port 27 Rx |2 words |32 bits |HEX 0x2334 |39013
Error Pack-
ets
Port 28 Rx |2 words |32 bits |HEX 0x2336 |39015
Error Pack-
ets
Port 29 Rx |2 words |32 bits |HEX 0x2338 |39017
Error Pack-
ets
Port 30 Rx |2 words |32 bits |HEX 0x233A |39019
Error Pack-
ets
Port 31 Rx |2 words |32 bits |HEX 0x233C |39021
Error Pack-
ets
Port 32 Rx |2 words |32 bits |HEX 0x233E |39023
Error Pack-
ets
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Overview

R
ETHERNET/IP

TRIAL PROTOCOLS

EtherNet/IP was introduced in 2001, and is the leading proven industrial automation commu-
nications technology based on standard Ethernet and Internet technology. Developed and
managed by ODVA, EtherNet/IP is open and supported by hundreds of supplier companies.

EtherNet/IP switches provide Faceplate, Add-on Instruction (AOIl), and Electronic Data Sheet
(EDS), so users can easily integrate with Rockwell systems or other EtherNet/IP systems to
monitor and configure switches.

ODVA certificated, EtherNet/IP switches are quite simply reliable and rugged.

Supported Hardware

B The following is a list of devices supported by the AOI program under Rockwell PLCs.
B As for other brands PLCs, users can integrate PLCs and switches using EDS files.

Table 3: Supported Hardware

Model Version

1756-L61 V19 and higher
1756-L62 V19 and higher
1756-L63 V19 and higher
1756-L64 V19 and higher
1756-L65 V19 and higher
1756-L71 V20 and higher
1756-L72 V19 and higher
1756-L73 V19 and higher
1756-L74 V19 and higher
1756-L75 V19 and higher
1769-L32E V19 and higher
1769-L35E V19 and higher
1769-L30ER V20 and higher

1769-L30ERM

V20 and higher

1769-L30ER-NSE

V20 and higher

1769-L33ER

V20 and higher

1769-L33ERM

V20 and higher

1769-L36ERM

V20 and higher

1769-L24ER-QB1B

V20 and higher

1769-L24ER-QBFC1B

V20 and higher

1769-L24ERM-QBFC1B

V20 and higher

1769-L16ER-BB1B

V20 and higher

1769-L18ER-BB1B

V20 and higher

1769-L18ERM-BB1B

V20 and higher
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Requirements

>[RIAL PROTOCOLS

SCADA Requirements
B AB FactoryTalk® View v8.0

Hardware

B Personal computer with an Intel Pentium 4 processor (2 GHz or faster processor recom-
mended).

B Memory (RAM): 1 GB (or more) for 32-bit systems. A minimum of 2 GB required for 64-
bit operating systems

Hard disk space: Minimum 1.5 G

B Human Machine Interface (HMI) requirements:

Model: AB 2711P-XXXXXX

PanelView Plus 6 (700 or higher)

PanelView Plus 7 (700 or higher)

Version 8.0

Operating System

The host computer must be equipped with any of the following operating systems to support
the AOI program operations.

B Windows XP 32/64bit Professional version or higher

B Window 7 32/64bit Professional version or higher

B Windows 8 64bit Professional version or higher

B Windows Server 2012 32/64bit Professional version or higher

Configuring the Controller Device

This section provides a path for configuring and programming the controller device. Once the
device is configured, the settings are saved to an AOI file for exporting to PLC devices.

Note!  PLC device is required before you can fully configure the device. The included
- software and installation guide for the PLC device from the manufacturer are
r@l required to fully configure the controller device.

Two possible methods for configuring and programming are available. The following outlines
the use of the Logix application and FactoryTalk® View ME, the latter of the two options.

For further reference, FactoryTalk® View is the application to allow you to generate a user
interface. Two possible Ul types are available, Machine Edition and Site Edition. The ME Ul is
intended for HMI devices, while the SE Ul is for a personal computer.

B Default enable:
— IGMP Snooping
— EtherNet/IP Protocol
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| Configuring in Logix

STRIAL PROTOCOLS

The Logix application provides the functionality required to create an AOI file. The
RSLogix5000 v19 or higher is required for this procedure.

1. Prior to getting started, locate the necessary example file(s) from the enclosed CD.

2. Locate the RSLogix5000 application and open it.

3. Once in the main menu, navigate to the File main menu and select Open to open an
existing file or New to create a new file.

4. If you selected New, the New Controller window displays. Select the hardware architec-
ture for your main board type. See the following image for further details.

— Click the Vendor drop-down menu to select the hardware vendor.

— Click the Type drop-down menu to select the type of hardware.

— Click the Revision drop-down menu to select the revisions variable.
— Tick the Redundancy Enabled field if required.

— In the Name field, enter the name to identify this controller.

— Inthe Description field, enter a brief description to better identify the new controller,
include items such as location, settings type, etc.

— Click the Chassis Type drop-down menu to select the chassis type.
— Use the Slot numeric entry field to identify the slot number.
— In the Create In field, click Browse to select the directory to save the settings.

— Click the Security Authority drop-down menu to enable the security authority func-
tion.
If security authority is enabled, the Use only the selected Security Authentication
and Authorization option is available. Tick the option to set authorization and authen-
tication to the selected security authority as configured in the Security Authority
field.
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5. Click OK to continue.

STRIAL PROTOCOLS

Note! If a matching file is already present, a prompt displays. Select Yes to replace the
D file or No to return to the previous menu.
=

New Contreller ﬁ
Vendor: Allen-Bradley
Type: 1756-L73 CortrolLogix® 5570 Controller v
. m

[~] Redundancy Enabled Help

Mame: SE_Test
Description: A
Chassis Type: 17567 7-Slot ControlLogix Chassis -
Slot: E_ = Safety Partrer Slat: <nones
Create In: C:\RSLogix 5000\Projects
Security Authority: [No Protection v]

Use only the selected Security Authority for Authentication and
Authorization

Figure 2: Creating a New Controller

For 1756 Series users see the following procedures, otherwise continue onto 6:
The following procedure creates an Ethernet module.

— Under the I/0 Configuration root, right-click on the available configuration and select
New Module to create an Ethernet controller. See the following figure.

. Add-On-Defined

-, Predefined

E'E] 10 Configuration
=¥ 11756 ‘
...ffa [0]1756-L7

ﬂ Mew Maodule...

Discover Modules...

2 Paste Ctrl+V
Properties Alt+Enter
Print r

Figure 3: Creating a New Ethernet Module

— The Select Module Type screen displays. Scroll down to select the following:
1756-ENBT (1756 10/100 Mbps Ethernet Bridge, Twisted-Pair Media
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— Click Create to continue and create a new controller listing.

STRIAL PROTOCOLS

r * — Y
# ° New Module M
General* | Connection I RSMetwons I Module Infa I Internet Protocol | Port Configuration
Type: 1756-ENBT 1756 10100 Mbps Ethemet Bridge, Twisted-Pair Media =
Vendor: Allen-Bradley
Parent: Local Ethemet Address
Name: SE_NEW_MODULE_TEST () Private Network: 192.168.1.
Description: - @) |P Address: 152 . 168 . 1 . 158 |
H
- () Host Name: A
Module Defigition W
Revision: ot 1
Electronic Keying: Compatible Module W
H
Rack Connection: None f
Time Sync Connection: None
I
Statuz: Creating “ QK ] [ Cancel ] [ Help ]

Figure 4: Selecting a Module Type

The newly created Module Properties listing displays, see the following figure.

=]l LaLd | ypes

.., User-Defined

E@o Strings
-8 Add-On-Defined

-, Predefined

-5 /0 Cenfiguration
=R 1756 Backplane, 1756-A7
- [0]1756-L73 BB_Test

=0 W [1] 1756-ENBT/A SE_NEW_MOD

Figure 5: Module Properties Listing

This ends the procedures specific to the 1756 series.
Users other than the 1756 series can continue here with the configuration procedure.
6. Select the Ethernet entry and right click on it to open the menu bar.
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7.

1.

STRIAL PROTOCOLS

Select New Module to define the module type, see the following figure.

0 Module-Def
----- 3 Trend ﬂ Mew Maodule...

Ctrl+V

Alt+Enter

Figure 6: Defining the Module Type

The Select Module Type window displays.

Under the Catalog tab, scroll down to find ETHERNET-MODULE type and select it.
Click Close on Create to close the displayed window (optional).

Click Create to continue.

Cetelog | Module Discovery | Favorites|

Erter Search Text for Modtde Tipe C‘hﬁrPihe:s‘g (Show Fillers ¥
Catalog Number Descnpbon Vendor Category ~

El41.. Floweszrve 400V ac 480V acH50Y 40 Reliancs Elsctric DP to EtherstTP

E151.. Flowesspve 600VacB10Vdc Relisnce Elctric DP! to EtheristTP

EKI-5629C EKI-5629C1 Advantech Corp...  Generie Devace(heyabls)

EtherNetTP SoflogSe00 EtherletTP Allen-Busdley Compnnacation

ETHERNET-ERIDGE Generic EtherNetTP CIP Brdge Allen-Bradley Comeninication

ETHERHNET-MODULE Generc Ethernet Module Allsn-Bradley Commandcation

ETHERNET-PANELVIEW EtherNot1P Panelview Allen-Bradley HMI

EX250-S8EN1 Ettemet Yalve Manifold SIU SMC Corporaton Commumcation

EX260-SENI Ethemet Yalve Mamfold SIU SMC Corporation  Commumication

EXI00-3EN2 Ethemet Valve Manifold 210 SMC Corporstion  Commumication

EXI60-ZENZ Ethemet Valve Mafold SIU SMC Corporaton  Cormumunication

EXI60-SEH4 Ettemet Volve Manifold SIU SMC C ; C st

EX500-GEN1 Ethemet Gateway SMC Corporabon  Commurnacation

FARUC CHNC EtterNet TP CHC FANUC CORPO.. Specalty

FANUC Robot EtterNetTF Robot FANUC Robotic.. Speculty -|
435 of 435 Module Types Found | Add o W=]
[ Close on Create [ Coer || [Chow | [ Hel

Figure 7: Creating an Ethernet Module Type
Select the General tab to modify the parameters. The Connection and Module Info
parameters are fixed and aren’t modifiable.

— In the Name field, enter the module name. In the following figure, SE_Module1 is
used.

— Under Connection Parameters, enter the values as shown in the following figure. The
parameters must match the stated values or the parameters found in the EDS file.

— Under Address / Host Name, select IP Address and enter the designated IP address
value.
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— If a secondary I/O Configuration is available, make sure to use a different name for
example SE_Module2.

TRIAL PROTOCOLS

~
New Module R Sl @
Type: ETHERMET-MODULE Generic Ethernet Module
Wendor: Allen-Bradley
Parent: Local
Mame: SE_Modulel Connection Parameters
Azsembly .
Description: o Instance: Size:
Input: 100 8 = | [32-hit)
T Oupt 150 B2 (26
C Format:| Data - DINT - - ; I
£rnin ZOMe:: |8l ] Configuration: 151 n — | [B-hit] [
Address / Host Name i
@ IP Address: 192 163 0 1 . 1| f
() Host Mame: "
Open Module Properties ” ok ]l [ Carcel ] [ Help ] :

Figure 8: Modifying Ethernet General Parameters

12. Select the Connection tab and set the Requested Packet Interval (RPI) field (suggested:
1000.0 ms).

13. Click OK to continue and return to the main screen.

5| Module Properties Report: EKI_NEW_MODULE_TEST (ETHERNET-MODULE 1.1) =)

Connection | Madule Infa

| Fequested Packet Interval [RPI): 100 me | (1.0-3200.0 ms)
[ Inhibit Module

[ Major Fault On Contraller IF Connection Fails ‘while in Fun Mode

Usze Unicast Connection over EtherMet/|P

Module Fault

Statuz: Offline |[ ak. ][ Cancel ] Apply
Figure 9: Modifying Ethernet Module Parameters

14. Click Tasks > MainTask > MainProgram to view MainRoutine.
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15. Right click on MainRoutine submenu and elect Open to display the Rung Routine win-
dow.

STRIAL PROTOCOLS

] Controller Tags

----- [ Controller Fault Handler
----- 3 Power-Up Handler
=-E5 Tasks

5@ MainTask

aEa MainProgram

_____ oo I
% Cut Ctrl+X

----- 3 Add-On Instructions Copy Ctrl+C

=-E3 Data Types 2 Paste Ctrl+V
' Cﬁ User-Defined Delete Del

@ Add-On-Defined  |[&f Verify
3 Predefined Cross Reference  Ctrl+E

Browse Logic...  Ctrl+L

=3 YO Configuration
-8 1756 Backplane, 175
eﬂ [0]11756-ENBT/A Export Routine...
-5 Ethernet

Print »

Properties Alt+Enter
[T A ERT NEW TMODUCE_TEST

P . [l 1756-ENE
Figure 10: Creating a Routine

16. Select a Rung Ladder and right click on it to open the Properties menu.
17. Scroll down and select Import Rungs.

Centroller Organi >~ 3 X T ;
on r:o er Organizer q mj E& % E3 5 b b
...[23 Controller Fault Handler -
3 Power-Up Handler e
-3 Tasks o &
H - -
9@ MainTask .
& MainProgram
Program Tags
.. MainRoutine # CutRung Ctrl+X
...l Unscheduled Programs / Phases Copy Rung Ctrl+C
[—]S Motion Groups 2 Paste Ctrl+V
...[3 Ungrouped Axes
----- 3 Add-On Instructions Delete Rung Del
-3 Data Types Add Rung Ctrl+R
.. User-Defined Edit Rung Enter
Cﬂ? Strings ) Edit Rung Comment Ctrl+D
Ly Add-O.n-Deﬂned = Import Rungs..
Cﬂ, Predefined
£, Module-Defined Export Rungs...
""" g Trends Start Pending Rung Edits  Ctrl+Shift+S
=] O Configurati
= v o.n guration Accept Pending Rung Edits
PointlQ ) )
£F [0]1769-L18ER-BB1B BB_Test Cancel Pending Rung Edits
1 Embedded /0 Assemble Rung Edit
[ Expansion /0, 0 Modules g g 5T
E-&5 Ethernet Verify Rung
[ 1769-L18ER-BB1B BB_Test
fl ETHERMET-MODULE SE_Mod ' Go To.. Ctrl+G

Figure 11: Selecting Import Rungs
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The Import Rungs window displays.

STRIAL PROTOCOLS

e ™
g Import Rungs e ' - ﬁ
Lookin: ) AQI - 0P E-
T MName ‘ Date modif.. Type Size
el =] AOL vl 1.L5% 2016/2/15 ... Logix Designer X... a7l

Recent Places

Into:

Eij TestRouting [t ainProgram)

Ovenwrite Selected Rungs

Desktop
r=n
Libraries
A
Computer
@
4 1 | +
MNetwork
File name: AQIv1_1.L5X -
Fiesof type:  RSLogi 5000 XML Fies (" L5X)
Files containing: | b={ Rungs Help

Before you can overwrite any of the selected Rung files, select the Overwrite Selected

Rungs option.

Figure 12: Importing a Rung File

e ™
g Import Rungs e ' - ﬁ
Lookin: ) AQI - 0P E-
T MName ‘ Date modif.. Type Size
el =] AOL vl 1.L5% 2016/2/15 ... Logix Designer X... a7l

Recent Places

Desktop
r=n
Libraries
A
Computer
@
4 1 | +
MNetwork
File name: AQIv1_1.L5X -
Fiesof type:  RSLogi 5000 XML Fies (" L5X)
Files containing: | b={ Rungs Help

Into:

Eij TestRouting [t ainProgram)

| Ovenwrite Selected Rungs |

Figure 13: Importing a Rung File
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18. Locate the target file and click Import to import the file and continue the process, see the

following figure.

Fo ™y
g Import Rungs LU adhad ﬁ
Look in: . ADI - @ ? - '
B MName : Date modif... Type Size
e | AOLv1 115K 2016/2/15 ... Logix Designer X... a7 if
Recent Places
Desktop
Libraries
[ |
Computer
@
4 1 | +
MNetwork
File name: AOI_v1_1.L5X -
Fiesof type:  RSLogi 5000 XML Fies (" L5X)
Files containing: | b={ Rungs Help
Into: Eij TestRouting [t ainProgram)
Ovenwrite Selected Rungs

Figure 14: Importing a Rung File

The Configure Rung Properties window displays.

1 ' Import Configuration

2559 % A

£ L Fnd
Find Withirn: Final Mame
Impar Contert:
& ManTad
t‘ [an
33 :n] MainR outine (Rungs)
& References
Y & Tags
U3 & AddOn Instruction:
U3 [ Data Types
h a Other Components

& Eros/wamings

Figure 15:

« B &8 FndReplace.

Configure Rung Properties
Imported Rungs: 1

Operation: [I’.‘reale V] after last Rung
0] References will be imported as
~ configured in the References folders
Routine Properties
Narme: MainRoutine
Description: F
Type: [B) Ladder Diagiam
In Program: |:i MainProgram

Configure Rung Properties

To configure a single SE switch setup, go to “Setting Message Configuration Parame-

ters” on page 38.

For a multiple SE switch configuration, see the following:

— Import a second AOlI file.

— Under TestRoutine (Rungs) > References, locate Tags.
— Locate and change all tags marked SE_Switch1 to SE_Switch2, see the following fig-

ure.
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— Click OK to complete the process.

TRIAL PROTOCOLS

F ™
# " Import Configuration &J
Find: + &8 [FndReplace..
Find “ithin: Final Name
|mport Content:
A MainTazk Configure Tag References
‘ Ea MalnPro_gram . Import Mame Operation _:_'J Final Mame ) g‘ Aliaz For Data Type | Descripl =
U3 b Eij MainR outine [Rungs] —
i References E Local1:C Usze Existing Local1:C == AB:Embed... i
s Tags E Local1:l Usze Existing Local1:1 == AB:Embed...
[Br] Add-On Instructions E Local1:0 Usze Existing Local:1:0 == AB:Embed...
U3 Data Types 8| MG_CFEM1 |Create 1 | MG_CF_EN1 = MESSAGE
B Evorsvons Dther Componerts g we_F Create 1 | Ma_iP1 o MESSAGE
frersAamings 8| MG_PacRatel |Create | MG_PacRatet |- MESSAGE
E MG_Storel Create | MG_Starel L MESSAGE 3
E MG_Stringl Create | MG_String1 L MESSAGE
E My_Switchl Create | My_Switchl L AQI_SE_S..
E SE_Modulel:l |Use Ewisting | |4 SE_Modulel:| L AB:ETHER...
E SE_Modulel:0 |Use Existing | |4 SE_Modulel:0 L AB:ETHER...
E SE_Switchi Create 1 | 5E_Switch1 =) SE_SWITCH =
4 [ | +
'l 1 | »
|[ QK ]I[ Cancel ] [ Help
u Feady

Figure 16: Configuring Tag References

Users with a single SE switch, it is not necessary to alter the Tag references. The default
values define the single SE switch.

Setting Message Configuration Parameters
Once the AOI is created and displays as seen in the following figure.

1. Locate the property value MSG_IP_Address and click the message configuration option
(MG_IP1).

m momom

AOLSE_SWITCH
B&B SE SWITCH —
AOLSE_SWITCH  My_Switch1 [
Switch_IP_Path IP_Path1 -
Input_Data SE_Module1:.Data
Output_Data SE_Module1:0.Data
Switch_Data g g itch

MSG_IP_Address WG_IP1 ()

MSG_Packet_Rate MG_PacRatel [...]

MSG_Store MG_Store1 (] =
MSG_Config EN  MG_CF_ENT [
MSG_String MG_String1 ]

(End) =

Figure 17: Setting Message Configuration Parameters
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2. The Message Configuration window displays. Locate the Communication tab and click

STRIAL PROTOCOLS

on it.
Message Configuration - MG_IP1 ﬂ
| Corvfiguratlonl C ication I Tag |
Message Type: [ClF‘ Generic -
Service [Getﬂmﬁingle v] Source Element
Type:
Source Length 0 = | [Byte i
Service .
Coder © (el Dlasst 15 Hedl  pognation EKI_Switchl IP_MGI( +
Elemert:

Instance: 1 Attribute: § [Hex] |@

) Enable 3 Enable Waiting 3 Start 2 Done Done Length: 0

) Emor Code: Extended Emor Code: "] Timed Qut &

Emor Path:

Emor Text: |

ok [Ccmesl ][ ooy | [ b ]

Figure 18: Configuring Communication Settings

The following step is required to set the communication path for the target switch.
3. Locate the Path field and click Browse to open the Message Path Browser.
4. The Message Path Browser window displays. Select the target switch and click OK to

continue.
. T A muvsiLugLal A 1
Message Configuration - MG_IP1
Communication | Tag
© Path: SE_Modulel
SE_Module1 s B
B ' Message Path Browser u
Broadcast: L]
witch1
Communication Method || Path: SE_Modulel Path1 = =
@ CIP DH+ Channel: A B 5E_Modulel :.Data
E _ .Data
CIP With e [ ¥
Sourt:e D Source Link: [0 BS 140 Configuration itch1
-3 Pointi0 ol %
[7] Connected Cach FE [0]1763-L13ER-BE1E BB _Test it o )
Embedded 1/0 F e O 3
------ @ [1]Embedded Discrete_|D stringt )
[Z3 Expangion 140, 0 Modules
3 Enable ) Enable Watting 2 Start Ethernet
G 1769-L18ER-EE1E BB
D El= SENEEE | ETHERNET MODULE SE_Module] L
Emor Path:
Emor Text:
' l.".'fi_": . ol

Figure 19: Selecting the Message Path
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The Packet Rate Message windows displays. In this event if the MG_IP1 MSG setting is
the only setting to change, other MSG settings do not require further configuration.

STRIAL PROTOCOLS

AD|_SE_SWITCH

AOLSE_SWITCH  My_Switch1 [
Switch_IP_Path IP_Path1
Input_Data SE_Module1:.Data
Output_Data SE_Module1:0.Data
Switch_Data SE_Switch1
MSG_IP_Address MG_IP1 [
MSG_Packet Rate MG_PacRatel (]
MSG_Store MG_Store1 (]
MSG_Config_EN MG_CF_EN1 [
MSG_String MG_String1 ]

(End)

Figure 20: Configuring Packet Rate Message

5.  Once the parameter is configured, download the program to the controller and set it to
run mode.

Configuring in FactoryTalk® View Machine Edition

1.  Open FactoryTalk® View Studio editor software (v7.0 or higher).

2. The Application Type Selection window displays. Select View Machine Edition, and
click Continue.

FactoryTalk View Studio m

|| Select the type of application you would like to configure:

i a =

View Site Edition View Site Edition View Site Edition View Machine Edition
(Network Distributed)  (Network Station) (Local Station)

[ Contirve | [  Ewt |

Figure 21: Opening FactoryTalk® View Studio Applications

The New/Open Machine Edition Application screen displays.
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3. Select the New tab to create a new file; see the following:
In the Application name field, enter the name of the file.
In the Description field, type a brief description of the file (optional).

Click the Language drop-down menu and select en-US to designate the language tag
for the file.

Enter an application name and click Create to create the new application file.

STRIAL PROTOCOLS

New/Open Machine Editicn Applicaticn pe— M
New | Bxisting
Application name: SE_ME
Description:

[7] Compact Machine Edition application

Check this box to create an application that will
run on a PanelView Plus Compact terminal.

Language: [Engiish {United States), en-US -

[ Create ] [ Import... ] [ Cancel ]

Figure 22: Creating an Application File

Or

4. You can open an existing application file, see the following:
— Click on the Existing tab to view a list of available files.
— Select an option from the list in the open panel.
— Click Open to open the existing file.

MNew/Open Machine Edition Application \ J

New | Bdsting

Application Name
ADV_KEN

BB_0503

BB_0705
BB_ME_0718
BB_ME_0715
BB_ME_0719_mer
BB_ME_0720
BB_Test
BlockMachine Demo

fm| »

Last Opened With: FactoryTalk View Studio 7.0

Resolution: PVPlus 700/1000 (640x420)

Language: [Engiish {United States), en-US -

Figure 23: Opening an Application File

5. Once the application file is open, you can add components to the configuration. If the
explorer window is not open, locate the main tool bar and click View > Explorer Window
to open the menu tree for the application file.

41



BB SMARTWORX

b AD\ANTECH

6.
7.

STRIAL PROTOCOLS

Under the Graphics folder, locate Images and right-click to open an options menu.
Click Add Components Into Applications.

Explorer - SE_ME

=& Local (HOME-PC)

=fn SE_ME

=8, SE_ME

EHER System

|§| Project Settings
- & Funtime Security

-] Disgnostics List Setup
- (3lobal Connections
Startup

a HMI Tags

29 Ghraphics

EJ-% Displays

Global Objects

»

m

; Symbol Factory
faf] Libiraries

Add Component Into Appl

ication... I

The Add Components Into Project window displays. Navigate to the location of the
source folder located in the included CD or download the required files from the web site.

Select all images in the Images folder (.png and .bmp), and click Open to import them.

To view specific supported formats, click the Format drop-down menu and select a spe-
cific format to display in the body pane.

-
2l Add Component Into Project M

o
@t}. . v B&B » FT_ME_v1_1 buildd001 » Images - ‘,I Search Images P|
0 @

Size

Organize « MNew folder 4= -

-

MName

Date Type

W Favorites
Bl Desktop
4. Downloads

2016/4/30 £+ 04:58
2016/4/30 £+ 04:58

& Homebmp Bitmap image

& left_Lbmp

Bitmap image

, GuiderLee

= Recent Places

4 Libraries
@ Documents

J’ Music

[ Pictures

EE videos

*& Homegroup

1M Computer
£, Local Disk (C3)

|& Page Down.bmp

2016/4/30 £+ 04:58

Bitmap image

|& Page Up.bmp

2016/4/30 £+ 04:58

Bitmap image

& port.bmp

2016/4/30 £+ 04:58

Bitmap image

& Port_AllLbmp

2016/4/30 £+ 04:58

Bitmap image

& right_Lbmp

2016/4/30 £+ 04:58

Bitmap image

2] SE408-ELbmp

2016/4/25 T4 02:23

Bitmap image

2] SE416-ELbmp

2016/4/25 T4 02:23

Bitmap image

| SEC410-25FP-ELbmp

2016/4/25 T4 02:23

Bitmap image

|| SEC418-25FP-ELbmp

2016/4/25 T4 02:23

Bitmap image

| SEG410-25FP-ELbmp

2016/7/5 EF11:21

Bitmap image

| & SFP.bmp

2016/4/30 £+ 04:58

Bitmap image

& top_Lbmp

2016/4/30 £+ 04:58

Bitmap image

-~ 4|

I

File name:  "SEC410-2SFP-ELbmp

" "5EC418-25FP-ELbmp ~

’Bitmaplmages (*.bmp)

[ Open |v] ’ Cancel

Figure 25: Importing Images

The images are imported and the main menu displays.
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11. Right-click to open the options menu and select Add Component Into Application....

TRIAL PROTOCOLS

= D 2 s (Mo
Explorer - SE_ME
=& Local (HOME-PC) -
=fn SE_ME T
=8, SE_ME
EHER System
|§| Project Settings
- & Funtime Security

-] Disgnostics List Setup
- (3lobal Connections

m

New

I:I tvmbol Facto
U‘E Libraries Add Component Into Application...
B Images

- [#] Parameters

| B m
Figure 26: Importing SE and HMI Objects

Import and Export...

12. The Add Components Into Project window displays. Navigate to the location of the
global objects source folder.

Organize « MNew folder =~ O '@'
% Favorites MName Date modified Type
Bl Desktop || HMI_Object.ggfx 2016/7/5 TF 01:26  GGFX File
& Downloads || SE_Object.ggfx 2016/7/5 F<F 01:19  GGFX File

, GuiderLee

= Recent Places

m

4 Libraries
3 Documents
J‘- Music

= Pictures

Figure 27: Add Components Into Project Window

13. Select the SE_Object and HMI_Object files and click Open to import them.

To view specific supported formats, click the Format drop-down menu and select a spe-
cific format to display in the body pane.

14. From the menu tree, navigate to Graphics > Displays.
15. Right-click to open the options menu and select Add Component Into Application....

Explorer - SE_ME =]
=& Local (HOME-PC) -
=fn SE_ME T
=8, SE_ME
EHET System
|§| Project Settings

- & Funtime Security

-] Disgnostics List Setup
- (3lobal Connections

New

Add Component Into Application...

Import and Export...

b m

Local Messages

Figure 28: Importing GFX Objects

16. The Add Components Into Project window displays. Navigate to the location of the
GFX Objects source folder.
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17. Select the five files in the GFX folder and click Open to import them.
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Organize « MNew folder =~ O '@'
% Favorites Mame . Date modified Type
Bl Desktop | || [ALARM].gfx 2016/7/5 F511:55  GFXFile
& Downloads || [DIAGMOSTICS].gfx 2016/7/5 F511:55  GFXFile
J GuiderLee || [INFORMATION].gfx 2016/7/5 F511:55  GFXFile
=] Recent Places | AlarmlList.gfx 2016/7/5 F511:55  GFXFile
|| Devicelnfo.gfx 2016/7/5 F4F 01:58  GFX File
4 Libraries = || MAIN.gfx 2016/7/5 F511:55  GFXFile
3 Documents || Portconfig.gfx 2016/7/5 E511:55  GFX File
J? Music | PortInfo.gfx 2016/7/5 F511:55  GFXFile
= Pictures
EE videos

Figure 29: Importing GFX Files

The GFX files are imported and the main menu displays.
18. From the menu tree, navigate to Graphics > Parameters.
19. Right-click to open the options menu and select Add Component Into Application....

Explorer - SE_ME =]
=& Local (HOME-PC) -
=fn SE_ME T
=8, SE_ME
EHET System
|§| Project Settings

- & Funtime Security

-] Disgnostics List Setup
- (3lobal Connections
Startup

23 HMI Tags

Ela Crraphics

(o] Displays

EJ-% (tlobal Objects

1;1 Symbol Factory

[ faf] Libiraries

(B Images

m

[ Low New
Ba Llarms Add Component Into Application...

- LB Alnmeewy
S Information Rl
Figure 30: Importing SE Param1 into Parameters

20. The Add Components Into Project window displays. Navigate to the location of the
parameter source folder.
21. Select SE_PARAM1 and click Open to import the files.

To view specific supported formats, click the Format drop-down menu and select a spe-
cific format to display in the body pane.

Organize = New folder =~ 0 @
< Favorites Name Date modified Type
Bl Desktop || SE_PARAML.par 2016/5/4 5 02:34 PARFile
& Downloads
| GuiderLee

= Recent Places

m

= Libraries

__q Documents

Jf Music

[&=] Pictures
Figure 31: Importing SE Param1 into Parameters

22. Click Open to import the files.

23. From the menu tree, locate the Communications tab at the bottom of the screen.
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24. Navigate to RSLinx Enterprise > Communication Setup and double click to open the
options menu.

STRIAL PROTOCOLS

[:]% RSLinx Enterprise

35---@;' Communication Setup

m ~ .
Figure 32: Locating RSLinx Enterprise List

25. Select Create a new configuration to create a new runtime configuration.
26. Click OK to continue.

.
RSLinx Enterprise Runtime Configuration Wizard [ =

Select an operation about runtime configuration:

¥ Create a new configuration,

™ Import a runtime corfiguration file,
T T ———

- Copy the corfiguration that is cumently
running on this workstation.

Finish Cancel | Heo |

Figure 33: Creating a New Runtime Configuration
27. Open RSLinx Enterprise, add a new Device Shortcut. For this example, name the device
shortcut CLX and select your PLC controller.
28. Click Apply and Copy from Design to Runtime.
29. Click OK to continue.

Eey Design Lol | Funtsme (1 apel] |
0 T Copp hom Diesir b Frunkins.
» o = 1 RSliny Enterprine, HOIME PC

1 B9 1739. 417, Backplane
25 Ftherbet, Ethemet
- [ 192.168.1.200, 1763 L18ER BE1E, FKIS
14 T34 Chassis 10, Paint0 Chassis 10 Slat
14 & USE, 17-Node LSE CIP Part

[Mode: Online Mot Browsing

Offire TagFie | Erouse.... |
Shottout Type  [Processor |

Fress Apcly button 8 assgn sekcted path to ths shortaut.

| ox JJcorel] vess] ee]
Figure 34: Adding a New Runtime Device Shortcut
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30. In the event that the Device Shortcut is not named CLX in RSLinx Enterprise, then the
imported parameters file (SE_PARAM1), must be modified, see the example and figure
as follows:

EXAMPLE:

— Open the SE_PARAM1 file.

— Change the non-remark line to read as follows:
#1=[CLX]SE_Switch1

— Save and close the parameters file.

STRIAL PROTOCOLS

[#] Untitled - /SE_ME/ (Parameters)
lI============ Parameter File Created 2016/11/2]1 ============
I Parameter files are used with graphic displays to specify the tags a display
I uses at run time. You assign parameter files in certain application components
I and object properties dialog boxes. Please see the Help for details.
I Syntax:
1 #replacement=tagname
I Example:
! #23=A_COLOR
1 #23 in any expression in a graphic would be replaced by the tag A_COLOR.

#1=[CLX]SE_Switch1
Figure 35: Altering Parameters File

31. In the Explorer window, navigate to Application > Create Runtime Application and
click on it.
32. Download the previously created parameter file to the device.

File Vew |App|tcat10n| Tools Window Help

~ == 2 Test Application
'Explorer Elt Create Runtime Application...

Application Properties...
T&S"RUntime Security
@ Diagnostics List Setup
- @& Global Connections
- Y® Startup [l
=23 HMITags
i, g Tags
- =53 Graphics
- w[ag] Displays
- @[] Global Objects
% Svmbol Factorv
Figure 36: Downloading File to the Device

33. Start the Runtime application.

The runtime application is configured and uploaded to the device effectively program-
ming the device through the FactoryTalk® View ME application.
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|Configuring in ME Image Control Panel

1.

Open human machine interface PanelView Plus.The following screen displays.

| AbvntecH E‘EH rwo n

Close

Figure 37: Opening ME Image Control Panel

Click Switch and enter the Device Information screen.
Different device models are represented by their respective images.

On the top right of the screen is a function bar (tool bar), with icons representing specific
tasks available in the PanelView Plus main menu.

SE416-EI-T

hAE X

Device Information

ADVMNTECH [[Se-im vt X

WOorx

SEA1B-ELT
IP Address:
Subnet Mark:

Gateway:

192 .168 . 1 . 1
255 .255.255. 0
192 168 . 1 | 254
N/A

0.19 Hour

Power Input:
Up Time:
CPU Usage: 23 %
Device Rev:  1.00.04

Mac Address: 00:D0:C9:00:00:24

Monday, November 21, 2016

o8 3 3 88

Etheri'et/IP’

2:24:59 PM CPU Usage 2:25114 PM

[ Active [ Disabled Ml nactive

Figure 38: Identifying Control Panel Menu

Table 4: Control Panel Menu

Function Description Function Description

Home page Displays port status
A pag E plays p
Configures port status 7 Alarm info
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3. Click the status icon to see the status for a selected port.

STRIAL PROTOCOLS

To switch between port selections, use the arrow icons (n or n) to select a specific
port.

82 uee  SE416-ELT w1X]

AEE N
Kl s | 8

Link Status: Active Port Utilization: 0 %
Link Speed:100 Mbps Port Duplex:  Full
TX Unicast (Packet/sec): 101

RX Unicast (Packet/sec): 60

TX Broadcast (Packet/sec): 0
[]
[]
1

RX Broadcast (Packet/sec):
TX Multicast (Packet/sec):
RX Multicast (Packet/sec):

Port & Utilization Monday, November 21, 2016

o8 3 3 28

2:25:37 PM 2:25:40 2:25:43 2:25:46 2:25:49 2:25:52 PM

Figure 39: Selecting Port Entries

4.  Click the tool [ icon to enter the Port Settings menu.
Select the setting to change and use the arrow icons (n or nq) to change the settings.

Click Enter to apply the new setting changes. If the Enter button is not pressed
the changes do not take effect.

B8 SE416-EI-T 11X

AEE N
Kl Fs | I3

Link Status: Active Port Utilization: 0%
Link Speed: 100 M/ Full Auto-Negotiation: Enable
CPU Utili Alarm Limit: 70 Port Utili Alarm Limit: 50

Port 5 Configuration :

Auto-Nego Disable

Auto-Nego Enable

CPU Utilization Alm Limit Paort Utilization Alm Limit Entan

Figure 40: Configuring Port Settings



BB SMARTWORX

b AD\ANTECH

7. If a setting is grayed out, the setting is cannot be modified.
When ports are disabled, the following options are not available: Auto-Nego, Port Speed,
and Port Duplex.
If Auto-Nego is Enabled, Port Speed and Port Duplex cannot be set.
CPU and Port utilization alarm limits are available at the bottom of the screen.

A numeric keypad displays to allow entry of limit values

>RIAL PROTOCOLS

Figure 41: Setting CPU, Port and Alarm Value Limits

8. After entering a value, click the return button to return to the previous window.

9. Click Enter |JE{E8 to apply the new setting changes.
E:EHI'J\RJHK SE416-EI-T vid x

AFE A
Kl s |

Port Utilization: 0%

Link Status: Active
Link Speed: 100 M/ Full Auto-Negotiation: Enable

CPU Utili Alarm Limit: 80 Port Utili Alarm Limit: 80

Port 5 Configuration :

Port Disable Auto-MNego Disable
Part Enable Auto-Mego Enable
’100Mbps ‘ ’Full ‘ n

CPU Utilization Alm Limit Port Utilization Alm | imit m

Figure 42: Setting CPU, Port and Alarm Value Limits

Enabling or disabling additional settings, such as the Alarm function, is also available
through the control panel.
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10. Click the alarm ZK icon to enter the alarm list.
If an image is grayed out, there are no active alarms.
An alarm function is active if the listing is in Red.
11. Click Enable or Disable to change the status of the selected alarm.

STRIAL PROTOCOLS

ETYTEESS...  SE416-ELT w1 X ETYTTESE ... SE416ELT w1 X
AEE X AR E X
EKI Switch Alarm List EKI Switch Alarm List
CPU Utilization Alarm

Figure 43: Enabling Alarm Options

Configuring in FactoryTalk® View Site Edition

1. Open FactoryTalk® View Studio editor software (v7.0 or higher).

2. The Application Type Selection window displays. Select View Site Edition, and click
Continue.

| b Selection- -
FactoryTalk View Studio M\

Select the type of application you would like to configure:
8 = ]

= =%

View Site Edition View Site Edition View Site Edition View Machine Edition
(Network Distributed)  (Network Station) (Local Station)

[ Contirve | [  Ewt |

Figure 44: Opening View Site Edition Applications

The New/Open Machine Edition Application screen displays.
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3.

STRIAL PROTOCOLS

Select the New tab to create a new file, see the following:
— Inthe Application name field, enter the name of the new application file.
— In the Description field, type a brief description of the file (optional).

— Click the Language drop-down menu and select en-US to designate the language tag
for the file.

— Enter an application name and click Create to create the new application file.

New/Open Site Edition (Local Station) ApplicaﬁonA u
Application name: SE_SE
Description:
Language: [English (United States), en-US ']

|[ Create ” Cancel ]

Figure 45: Creating an Application File

Or

You can open an existing application file, see the following:
— Click on the Existing tab to view a list of available files.
— Select an option from the list in the open panel.

— Click Open to open the existing file.

.
New/Open Site Edition (Local Station) Application =5

New | Bdsting

Application Name

1224
BB_SE_0504
BB_SE_Test
EDS_Switch_SE_20121002 =
EKI_0127

EKI_0525

EKI_1218

EKI_1224

FKI1_huiildN0N4
Language: [Engish (United States), en-US -

»

m

|[ COpen ][ Cancel ]

Figure 46: Opening an Application File

Once the application file is open, you can add components to the configuration. If the
explorer window is not open, locate the main tool bar and click View > Explorer Window
to open the menu tree for the application file.

Under the Graphics folder, locate Images and right-click to open an options menu.
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7. Click Add Components Into Applications to select it.

W Startup
=1 E‘i HMI Tags

o [ Displays
- o [@F Globel Objects

- =il Symbol Factory
- [ Libraries

JUSTRIAL PROTOCOLS

Add Component Into Application...

5 ﬁ Alsrms
~B Alarm Setup
.:ra Information
B Information Setop
% Information Mesages
=9 Logie and Control
[&] Macros
= :ﬂ Data Log
Figure 47: Importing an Image File

8. The Add Components Into Project window displays. Navigate to the location of the
image source folder.

9. Select the images to import and click Open to import the images.

To view specific supported formats, click the Format drop-down menu and select a spe-
cific format to display in the body pane.

2 Add Component Into Project ‘ M
el
@ . » B&B » FT_SEvLI1 buildo00L » Images ~ [ 43 ||| Search images P

Organize « MNew folder = 0 @
I T i II'\Iame } . Date. . Type . ) Size it |
M Desktop |. [#| Home. bmp 2016/1/4 T4F 02:06 Bitrap image
4 Downloads | | & left_Lbmp 2015/12/17 T4 04:00 Bitmap image
| GuiderLee |. Page Down.bmp 2016/1/4 T4F 02:06 Bitrap image
“El Recent Places |. Page Up.bmp 2016/1/4 T 02:06 Bitmap image
|. port.bmp 2016/1/4 T4F 02:06 Bitmap image
il Libraries £ |. & Port_All.bmp 2016/1/4 T4F 02:06 Bitrap image
% Documents | right_Lbmp 2015/12/17 T4 04:00 Bitmap image
& Music | 2] SE408-ELbmp 2016/4/25 T4 02:23 Bitmap image 1
[ Pictures |. %] SE416-ELbmp 2016/4/25 5 02:23 Bitmap image 2
EE videos |. & SEC410-2SFP-ELbmp  2016/4/25 5 02:23 Bitmap image 28
|. & SEC418-2SFP-ELbmp  2016/4/25 5 02:23 Bitmap image 2
% Homegroup — |. & SEG410-2SFP-ELbmp  2016/7/5 £ 11:21 Bitmap image 1
|. \&| SFP.bmp 2016/1/4 T4F 02:06 Bitmap image
18 Computer |. top_Lbmp 2015/12/17 FF 04:00 Bitrap image -
&, local Disk (C)  ~ < | mn | r
File pame: "416.bmp" "418.bmp" "advantech-bb.bmp" ' + ’Bilmap Images (*.bmp) v]
I Open |VI ’ Cancel ]

Figure 48: Importing Images

The images are imported and the main menu displays.
10. From the menu tree, navigate to Graphics > Global Objects.
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11. Right-click to open the options menu and select Add Component Into Application....

TRIAL PROTOCOLS

Explorer - SE_SE =]
S SE_SE p
53 Syeem

New
EII-@I Libraries Add Component Into Application...
wk Imagesl Import and Export...

- 0 Recipes

Local Messages
% Trend Templates
-F) Trend Snapshots
123 HMI Tag Alarms
A0 Alarm Setup
&" Suppressed List

Figure 49: Importing SE and HMI Objects

12. The Add Components Into Project window displays. Navigate to the location of the
global objects source folder.

Organize « MNew folder =~ O '@'
% Favorites MName Date modified Type
Bl Desktop || HMI_Object.ggfx 2016/7/5 TF 01:26  GGFX File
& Downloads || SE_Object.ggfx 2016/7/5 F<F 01:19  GGFX File
J GuiderLee

= Recent Places

m

4 Libraries
3 Documents
J‘- Music

= Pictures

Figure 50: Importing SE and HMI Objects

13. Select the objects to import and click Open to import them.
To view specific supported formats, click the Format drop-down menu and select a spe-
cific format to display in the body pane.

14. From the menu tree, navigate to Graphics > Displays.

15. Right-click to open the options menu and select Add Component Into Application....

Explorer - SE_SE =]

-

Add Component Into Application...
fagf] Libivarie :
mport and Export...

- 0 Recipes
Local Messages
% Trend Templates

m

dgw Buppressed List

Figure 51: Importing GFX Objects

16. The Add Components Into Project window displays. Navigate to the location of the
GFX Objects source folder.
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17. Click Open to import the files in the GFX folder.

STRIAL PROTOCOLS

Organize = New folder = - [l &
St Favorites Ti Mame 3 Date modified Type
B Desktop [ ] AlarmList.gfx 2016/5/4 £ 1021 GFXFile
& Downloads | _ Devicelnfo.gfx 2016/5/4 E51025  GRXFile
| Guiderlee | ] Main.gfx 2016/5/4 £ GFX File
1L Recent Places | __| Portconfig.gfx 2016/5/4 & GFX File
2| | L] Portinfo.g 2016/5/4 E=10:21  GFX File
A Libraries
= Documents
& Music
&=/ Pictures
E Videos
% Homegroup
"8 Computer et . | =
e o LA L

File name: “AlarmList.gfy' ‘Devicelnfo.gh' "Mai ~ | Graphic Displays (*.gfx ".ggfi) v]

|| Open |v] [ Cancel |

Figure 52: Importing GFX Files

The object files are imported and the main menu displays.

18. Import SE Param1 from the PAR folder, into Parameters. From the menu tree, navigate
to Graphics > Parameters.

19. Right-click to open the options menu and select Add Component Into Application....

{) Uiagnostics List Setup
. & Global Connections
P Startup
= HMITags
& Tags
=23 Graphics
:j{;g Displays
:+;E Global Objects
i Symbol Factory
.+;g Libraries
& Images
R ™ L
Local M New
=23 Alarms I_ Add Component Into Application_l
LB} Alarm Setip ™ TR
=5 Information
. @ Information Setup
Information Messages
=3 Logic and Control
[@ Macros
=2} Data Log

m

Figure 53: Impo‘rting SE Paraml into Parameters

20. The Add Components Into Project window displays. Navigate to the location of the
parameter source folder.
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21. Select the parameter files to import and click Open to import the files.
To view specific supported formats, click the Format drop-down menu and select a spe-
cific format to display in the body pane.

JUSTRIAL PROTOCOLS

Organize = New folder = 0 @
2 Eavordes * Name Date modified Type

M Desktop || SE_PARAMI.par 2016/5/4 T 02:34 PARFile

& Downloads

. GuiderLee

&)
5| Recent Places

m

3 Libraries
@ Documents

J‘ Music

[&=] Pictures
Figure 54: Importing SE Param1 into Parameters

22. Click Open to import the files.
23. Create a Data Server: Select the project name (SE_ADVE), and right click to display
Add New Server > Rockwell Automation Device Server (RSLinux Enterprise).

Explorer - SE_SE =]
=4 Lacal (HOME-FC) -
EIS& 5 Delete I ﬂ
=4 Add Mew Server 4 Rockwell Automation Device Server (R5Linx Enterprise)...
ST OPC Data Server...
& Tag Alarm and Event Server...
Properties... |

[ fadf] Displays

EJ-% (tlobal Objects
; Symbol Factory
[ faf] Libiraries
B Tmages
[ [#] Parameters
- 0 Recipes
Local Messages
@ Trend Templates
B Trend Snanshnts

Figure 55: Creating a data server

m

24. Navigate to RSLinx Enterprise > Communication Setup and double click to open the
options menu.

= B4 RSLinx Enterprise

ﬂ Communication Setup

(-\—l ~ .
Figure 56: Locating RSLinx Enterprise List

25. Select Create to create a new runtime configuration.
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26. Click Finish to continue.

STRIAL PROTOCOLS

.
RSLinx Enterprise Runtime Configuration Wizard [ =

Select an operation about runtime configuration:
% Create a new corfiguration,
™ Import a runtime corfiguration file,

" Export & runtime configuration i

- Copy the corfiguration that is cumently
running on this workstation.

Finish Cancel | Heo |

Figure 57: Creating a New Runtime Configuration

27. Open RSLinx Enterprise, add a new Device Shortcut. For this example, name the device
shortcut CLX and select your PLC controller.

28. Click Apply and Copy from Design to Runtime.
29. Click OK to continue.

Device Shortauts Pamay |
Remove Apply 5B} RSLinx Enterprise, HOME-PC
9 1789-A17, Backplane
» ax
=& EtherNet, Ethernet
[{§192.168.1.200, 1769-L18ER-BB1E, EKI S
Maode: Online Not Browsing
Offine TagFie | Browse... |
Shortrut Type  [Processar =

IFhis path is currently assigned to the selected shortcut.

Figure 58: Adding a New Runtime Device Shortcut
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30. In the event that the Device Shortcut is not named CLX in RSLinx Enterprise, then the
imported parameters file (SE_PARAM1) must be modified, see the example and figure
as follows:

EXAMPLE:

— Open the SE_PARAM1 file.

— Change the non-remark line to read as follows:
#1=[CLX]SE_Switch1

— Save and close the parameters file.

TRIAL PROTOCOLS

[#] Untitled - /SE_ME/ (Parameters)
lI============ Parameter File Created 2016/11/2]1 ============
I Parameter files are used with graphic displays to specify the tags a display
I uses at run time. You assign parameter files in certain application components
I and object properties dialog boxes. Please see the Help for details.
I Syntax:
1 #replacement=tagname
I Example:
! #23=A_COLOR
1 #23 in any expression in a graphic would be replaced by the tag A_COLOR.

-#1 =[CLX]SE_Switch1
Figure 59: Altering Parameters File

31. To complete the procedure, create a Client link and turn it on.

Configuring in SE Image Control Panel

1. Open man-machine PanelView Plus.The following screen displays.

I SE_SE - FactoryTalk View SE Client

ADMNTECH IS5

- TR T TR T

Figure 60: Opening SE Image Control Panel
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2.

STRIAL PROTOCOLS

Click the device image to enter the Device Information screen.
Different device models are represented by the respective image.

On the top right of the screen is a function bar (tool bar) with icons representing a specific
task available in the PanelView Plus main menu.

SviarTwORX SE416-EI-T vig (X

A FEX

Device Information

IP Address: 192. 168. 1 . 1
Subnet Mark: 255. 255. 255. 0
Gateway: 192. 168. 1 . 254

Power Input:

Up Time: 0.86 Hour
CPU Usage: 27T %
Device Rev:  1.00.04

N/A

Mac Address: 00:D0:C9:00:00:24

Monday, November 21, 2016

Etheri'et/IP’

o8 3 3 88

1
1 Ll

3:04:38 PM CPU Usage 3:04:53 PM

[ Active [ pisabled Ml nactive

Figure 61: Identifying Control Panel Menu
Table 5: Control Panel Menu

Function

Description Function Description

Home page Displays port status
A pag E plays p
Configures port status X Alarm info

3. Click the status [7] icon to see the status for a selected port.

To switch between port selections, use the arrow icons (n or n) to select a specific
port.
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4.  Click the tool [ icon to enter the Port Settings menu.
PO 52, o SE416-EL-T i

alE 2w |
Kl [rot5 | I

STRIAL PROTOCOLS

Link Status: Active Port Utilization: 0%
Link Speed: 100 M/ Full Auto-Negotiation: Enable
CPU Utili Alarm Limit: 2 Port Utili Alarm Limit: 78

Port 5 Configuration :

Port Disable Auto-Nego Disable

Part Enable Auto-MNego Enable

Figure 62: Port Settings Menu

Select the setting to change and use the arrow icons (n or nq) to change the settings.
Click Enter to apply the new setting changes. If the Enter button is not pressed
the changes do not take effect.

If a setting is grayed out, the setting is cannot be modified.

Disabled ports the following options are not available: Auto-Nego, Port Speed, and Port
Duplex.

If Auto-Nego is Enabled, Port Speed and Port Duplex cannot be set.

CPU and Port utilization alarm limits are available at the bottom of the screen. After

entering a value, click the return button to return to the previous window.

7.  Click Enter to apply the new setting changes.

TN 22 SE416-El-T a1 X
8B x| |
—- e

Link Status: Active Port Utilization: 0%

Link Speed: 100 M/ Full Auto-Negotiation: Enable
CPU Utili Alarm Limit: 80 Port Utili Alarm Limit: 80

Port 5 Configuration :

Port Disable Auto-MNego Disable

Part Enable Auto-MNego Enable

Figure 63: Setting CPU, Port and Alarm Value Limits
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Enabling or disabling additional settings, such as the Alarm function, is also available
through the control panel.

TRIAL PROTOCOLS

8. Click the alarm 2K icon to enter the alarm list.
If an image is grayed out, there are no active alarms.
An alarm function is active if the listing is in Red.
9. Click Enable or Disable to change the status of the selected alarm.

Cavvnrec ERN SE416-EI-T i1 B avanrec: o SE416-EI-T w1 X
. X f A X
EKI Switch Alarm List EKI Switch Alarm List
CPU Utilization Alarm

Figure 64: Enabling Alarm Options

EtherNet/IP CIP Objects

The following section identifies supported Common Industrial Protocol (CIP) objects. SE serial
device server line supports the following monitoring objects for PLC and SCADA devices:

B Identity Objects

TCP/IP Interface Objects
Ethernet Link Objects
Networking Objects
Assembly Objects

Message Router Objects
Connection Manager Objects
B Base Switch Objects

| Identity Objects

Class Attribute List
Table 6: Class Attribute List

Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
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Table 6: Class Attribute List (Continued)

STRIAL PROTOCOLS

Attribute ID  Access Rule Name Data Type Description
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device
Instance Attribute Lists
Table 7: Instance Attribute Lists
Attribute ID  Access Rule Name Data Type Description
1 Get VendorID UINT (16) ODVA Vendor ID. B&B = 148
2 Get DeviceType UINT (16) 43, Generic device
3 Get ProductCode |UINT (16) Please reset to Product Code
Table
4 Get Revision Struct
Major SINT (8) The structure member, major
Minor SINT (8) The structure member, minor.
5 Get Status DINT (32) Summary status of device
6 Get SerialNumber |UDINT (32) Serial number of device, the
default is 1234567890
7 Get ProductName |Short STRING Human readable identification,
Please reset to Product Name
Table
Common Service
Table 8: Common Service
Service Code Class Instance Service Name Description
0x01 ) . Get_Attributes_All|Returns multiple attributes in
numerical order.
0x0E ° . Get_Attribute_Sin |Read instance attribute of the
gle class
0x05 ° Reset Rest the device
GetAttributeAll
Table 9: GetAttributeAll
Ox1
1 VendorID UINT (16)
2 DeviceType UINT (16)
3 ProductCode UINT (16)
4 Revision
Major SINT (8)
Minor SINT (8)
5 Status DINT (32)
6 SerialNumber UDINT (32)
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Table 9: GetAttributeAll

STRIAL PROTOCOLS

Ox1
7 ProductName
length SINT (8)
data length SINT
TCP/IP Interface Objects
Attribute ID
Table 10: Attribute ID
Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device
Instance Attribute List
Table 11: Instance Attribute List
Attribute ID  Access Rule Name Data Type Description
1 Get Status UDINT (32) Interface status
2 Get Configuration_ [UDINT (32) Interface capability flags
Capability
3 Get/Set Configuration_ [UDINT (32) Interface control flags
Control
4 Get Physical Link |Struct
Object
Path size UINT (16) Size of Path
Path Padded EPATH |Logical segments identifying the
physical link object
5 Get Interface Con- |Struct
figuration
IP Address UDINT (32) The device's IP address
Network Mask |UDINT (32) The device's network mask
Gateway UDINT (32) Default gateway address
Address
Name Server |UDINT (32) Primary name server
Name Server2 |UDINT (32) Secondary name server
Domain Name |STRING Default domain name
6 Get Hostname STRING Host name
8 Get TTL value USINT (8) TTL value for EtherNet/IP multi-
cast packets
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Table 11: Instance Attribute List (Continued)
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Attribute ID  Access Rule Name Data Type Description
9 Get Mcast Config |Struct Multicast address allocation con-
trol word
Alloc Control [USINT (8) allocation control
Reserved USINT (8) Reserved for future use
Num Mcast UINT (16) Number of IP multicast address to
allocation for EIP
Mcast Start UDINT (32) Starting multicast address from
Addr which to begin allocation.

13 Set Encapsulation |[UINT (16) Number of seconds of inactivity
Inactivity of before TCP connection is closed
inactivity
before Timeout

Common Service

Table 12: Common Service

Service Code Class Instance Service Name Description
0x01 ) ° Get_Attributes_All|Returns multiple attributes in
numerical order

0x0E ° ° Get_Attribute_Sin |Read instance attribute of the
gle class

0x10 ° Set_Attribute_Sin |Write instance attribute of the
gle class

GetAttributeAll

Table 13: GetAttributeAll

0x1
1 Status UDINT (32)
2 Configuration_Capability UDINT (32)
3 Configuration_Control UDINT (32)
4 Physical Link Object
Path size UINT (16)
Path size path size UINT
5 Interface Configuration
IP Address UDINT (32)
Network Mask UDINT (32)
Gateway Address UDINT (32)
Name Server UDINT (32)
Name Server2 UDINT (32)
Domain Name
Length UINT (16)
Data length SINT
6 Hostname
Length UINT (16)
Data length SINT
Reserved 6SINT (48)
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Table 13: GetAttributeAll (Continued)

STRIAL PROTOCOLS

Ox1
8 TTL value USINT (8)
9 Mcast Config
Alloc Control USINT (8)
Reserved USINT (8)
Num Mcast UINT (16)
Mcast Start Addr UDINT (32)
Reserved 37SINT (37)
13 Encapsulation Inactivity of inactiv- |UINT (16)
ity before Timeout
Ethernet Link Objects
Class Attribute List
Table 14: Class Attribute List
Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device
Instance Attribute List
Table 15: Instance Attribute List
Attribute ID  Access Rule Name Data Type Description
1 Get Interface UDINT (32) Interface speed currently in use.
Speed Speed in Mbps (e.g., 0, 10, 100,
1000, etc.)
2 Get Interface Flags |[UDINT (32) Interface status flags
3 Get Physical ARRAY of 6 MAC layer address
Address USINT (48)
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Table 15: Instance Attribute List (Continued)
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Attribute ID  Access Rule Name Data Type Description
4 Get Interface Struct

Counters

In Octets UDINT (32) Octets received on the interface

In Ucast Pack- |UDINT (32) Unicast packets received on the

ets interface

In NUcast UDINT (32) Non-unicast packets received on

Packets the interface

In Discards UDINT (32) Inbound packets received on the
interface but discarded

In Errors UDINT (32) Inbound packets that contain
errors (does not include In Dis-
cards)

In Unknown UDINT (32) Inbound packets with unknown

Protos protocol

Out Octets UDINT (32) Octets sent on the interface

Out Ucast UDINT (32) Unicast packets sent on the inter-

Packets face

Out NUcast UDINT (32) Non-unicast packets sent on the

Packets interface

Out Discards |UDINT (32) Outbound packets received on the
interface but discarded

Out Errors UDINT (32) Outbound packets that contain
errors (does not include In Dis-
cards)
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Table 15: Instance Attribute List (Continued)
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Attribute ID  Access Rule Name Data Type Description
5 Get Media Coun- |Struct
ters
Alignment UDINT (32) Frames received that are not an
Errors integral number of octets in length
FCS Errors UDINT (32) Frames received that do not pass
the FCS check
Single Colli-  |UDINT (32) Successfully transmitted frames
sions which experienced exactly one
collision
Multiple_Collisi|UDINT (32) Successfully transmitted frames
ons which experienced more than one
collision
SQE_Test Err |UDINT (32) Number of times SQE test error
ors message is generated
Deferred_Tran |UDINT (32) Frames for which first transmis-
smissions sion attempt is delayed because
the medium is busy
Late Collisions |UDINT (32) Number of times a collision is
detected later than 512 bit- times
into the transmission of a packet
Excessive_Col |UDINT (32) Frames for which transmission
lisions fails due to excessive collisions
MAC_Transmit|UDINT (32) Frames for which transmission
_Errors fails due to an internal MAC sub
layer transmit error
Carrier_Sense |UDINT (32) Times that the carrier sense con-
_Errors dition was lost or never asserted
when attempting to transmit a
frame
Frame_Too L |UDINT (32) Frames received that exceed the
ong maximum permitted frame size
MAC_Receive |UDINT (32) Frames for which reception on an
_Errors interface fails due to an internal
MAC sub layer receive error
6 Get/Set Interface Con- |Struct
trol
Control Bits UINT (16) Interface Control Bits
Forced_Interfa |[UINT (16) Speed at which the interface shall
ce_Speed be forced to operate. Speed in
Mbps (10, 100, 1000, etc.)
10 Get Interface Level |STRING Human readable identification
100 Get Interface Utili- [UINT (16) Percentage of entire interface Rx/
zation Tx bandwidth being used (0-100),
rx - 8bits, tx-8bits
101 Get Tx Unicast UDINT (32) Number of TX unicast packets per
Packet Rate second
102 Get Tx Multicast  |UDINT (32) Number of TX multicast packets
Packet Rate per second
103 Get Tx Broadcast |UDINT (32) Number of TX broadcast packets
Packet Rate per second
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Table 15: Instance Attribute List (Continued)
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Attribute ID  Access Rule Name Data Type Description

104 Get Rx Unicast UDINT (32) Number of RX unicast packets per
Packet Rate second

105 Get Rx Multicast |UDINT (32) Number of RX multicast packets
Packet Rate per second

106 Get Rx Broadcast |UDINT (32) Number of RX broadcast packets
Packet Rate per second

107 Get/Set Broadcast USINT (8)
Storm

108 Get Authentication |USINT (8)
status

Common Service

Table 16: Common Service

Service Code Class Instance Service Name Description

0x01 ) . Get_Attributes_All|Returns multiple attributes in

numerical order.
0x0E ° ° Get_Attribute_Sin |Read instance attribute of the
gle class
0x10 . Set_Attribute_Sin |Write instance attribute of the
gle class
0x4C ° Get_and_Clear |Get instance attribute of the class
and then clear the value
GetAttributeAll

Table 17: GetAttributeAll

0x1

1 Interface Speed UDINT (32)

2 Interface Flags UDINT (32)

3 Physical Address B6USINT (48)

4 Interface Counters
In Octets UDINT (32)
In Ucast Packets UDINT (32)
In NUcast Packets UDINT (32)
In Discards UDINT (32)
In Errors UDINT (32)
In Unknown Protos UDINT (32)
Out Octets UDINT (32)
Out Ucast Packets UDINT (32)
Out NUcast Packets UDINT (32)
Out Discards UDINT (32)
Out Errors UDINT (32)
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Table 17: GetAttributeAll (Continued)
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0x1

5 Media Counters
Alignment Errors UDINT (32)
FCS Errors UDINT (32)
Single Collisions UDINT (32)
Multiple_Collisions UDINT (32)
SQE_Test_Errors UDINT (32)
Deferred_Transmissions UDINT (32)
Late Collisions UDINT (32)
Excessive_Collisions UDINT (32)
MAC_Transmit_Errors UDINT (32)
Carrier_Sense_Errors UDINT (32)
Frame_Too_Long UDINT (32)
MAC_Receive_Errors UDINT (32)

6 Interface Control
Control Bits UINT (16)
Forced_Interface_Speed UINT (16)

10 Interface Level
Length UINT (16)
Data length SINT

GetAttributeAll-Vendor1
Table 18: GetAttributeAll-Vendorl

100 Interface Utilization USINT (8)
101 Tx Unicast Packet Rate UDINT (32)
102 Tx Multicast Packet Rate UDINT (32)
103 Tx Broadcast Packet Rate UDINT (32)
104 Rx Unicast Packet Rate UDINT (32)
105 Rx Multicast Packet Rate UDINT (32)
106 Rx Broadcast Packet Rate UDINT (32)
107 Broadcast Storm USINT (8)
108 Authentication status USINT (8)
B&B Networking Objects
Class Attribute List
Table 19: Class Attribute List
Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
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Table 19: Class Attribute List (Continued)
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Attribute ID  Access Rule Name Data Type Description
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device
Instance Attribute List
Table 20: Instance Attribute List
Attribute ID  Access Rule Name Data Type Description
1 Get System UDINT (32) Number of seconds since device
Uptime was powered up
2 Get FW version Struct
Major1 USINT (8) The structure member, major1
Major2 USINT (8) The structure member, major2
Minor USINT (8) The structure member, minor
Reserved USINT (8)
3 Get System Fault |UDINT (32) System fault status
0 bit: CPU utilization alarm
value 0: no alarm
value 1: alarm
1 bit: Power supply 1
value O: error
value 1: ok
2 bit: Power supply 2
value O: error
value 1: ok
[3-31] bit: Reserved
4 Get Port Count USINT (8) Total switch port count
5 Get Port Exist UDINT (32) Switch port exists on device
6 Get/Set Port Enable UDINT (32) Switch port en|dis-able
7 Get Port Link Sta- |UDINT (32) Switch port link status
tus
8 Get CPU Usage USINT (8) Percent of CPU usage (0-100)
9 Get/Set Temperature |UDINT (32) Upper temperature (C) at which to
Upper Limit declare an alarm
10 Get/Set Temperature |UDINT (32) Lower temperature (C) at which to
Lower Limit declare an alarm
11 Get Temperaturein |UDINT (32) Temperature in degrees C.
C 0x9999 = Not Supported on
device.
12 Get Temperaturein |UDINT (32) Temperature in degrees F. 0x9999
F = Not Supported on device.
13 Set MIB Reset USINT (8) Reset MIB counters
14 Get/Set CPU Utiliza-  |USINT (8) Percent of upper CPU usage at
tion Alarm which to declare an alarm, default
Limit value is 80
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Table 20: Instance Attribute List (Continued)
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Attribute ID  Access Rule Name Data Type Description
15 Get/Set Port Utilization |USINT (8) Percent of upper port utilization at
Alarm Limit which to declare an alarm, default
value is 80
16 Get/Set Config Enable |USINT (8) Output config data en|dis-able
17 Get MAC address |Short STRING Human readable mac address
25 Set Reboot USINT (8) Reboot the device
GetAttributeAll
Table 21: GetAttributeAll
Ox1
1 System Uptime  |UDINT (32)
2 FW version
Major UINT (16)
Minor UINT (16)
3 System Fault UDINT (32)
0 bit: CPU utilization alarm
value 0: no alarm
value 1: alarm
1 bit: Power supply 1
value O: error
value 1: ok
2 bit: Power supply 2
value O: error
value 1: ok
[3-31] bit: Reserved
4 Port Count USINT (8)
5 Port Exist UDINT (32)
6 Port Enable UDINT (32)
7 Port Link Status |UDINT (32)
8 CPU Usage USINT (8)
9 Temperature UDINT (32)
Upper Limit
10 Temperature UDINT (32)
Lower Limit
11 Temperature in C |UDINT (32)
12 Temperature in F |UDINT (32)
14 CPU Utilization USINT (8)
Alarm Limit
15 Port Utilization USINT (8)
Alarm Limit
16 Config Enable USINT (8)
17 MAC address
length USINT (8)
data length USINT
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Table 22: Assembly

Instance Number Size (bit)

Input 100 256
Output 150 256
Config 151 80

Class Attribute List
Table 23: Class Attribute List

Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object Revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device

Instance Attribute List
Table 24: Instance Attribute List

Attribute ID  Access Rule Name Data Type Description
3 Get/Set Data Array of BYTE The messaging content

Common Service

Table 25: Common Service

Service Code Class Instance Service Name Description

0x0E ° ° Get_Attribute _Sin |Read instance attribute of the
gle class

0x10 . Set_Attribute_Sin |Write instance attribute of the
gle class

I/0O Data

Table 26: 1/0 Data

Input BitMask Name Bits Description

[0] 0-15 ProductCode |16 bits SE408-PN-T=0x5D58, SEC410-
2SFP-PN-T=0x5E59, SE416-PN-
T=0x5D56, SEC418-2SFP-PN-

T=0x5E56
16-23 CPU usage 8 bits Percent of CPU usage (0-100)
24-31 Reserved
[1] 0-31 Port status 32 bits Switch port link status
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Table 26: 1/0 Data
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Input BitMask Name Bits Description
[2] 0-31 Port duplex 32 bits Switch port duplex status
[3] 0-31 System uptime |32 bits Number of seconds since device
was powered up
[4] 0-31 System fault |32 bits The same result with no.3 attri-
bute of B&B class.
[5] 0-31 Port utilization |32 bits port will be set if port utilization
alarm exceed threshold.
[6] 0-31 Port Auth sta- |32 bits port authentication status
tus
[7] Reserved
Output
[0] 0-7 Port number |8 bits Which port number want to set
8 Port en | 1 bit Port number en | disable, 0 = dis-
disable able, 1 = enable
9 Port auto-nego |1 bit Port auto-negotiate en | disable, 0
en|dis-able = disable, 1 = enable
10 Port duplex 1 bit Port duplex, 0 = half, 1 = full
11-15 5 bits Reserved
16-31 Port speed 16 bits Port speed
[1] 0-7 CPU utiliza- 8 bits Percent of upper CPU usage at
tion limit which to declare an alarm
8-15 Port utilization |8 bits Percent of upper port utilization at
limit which to declare an alarm
16-23 Temperature |8 bits Upper temperature (C) at which to
upper limit declare an alarm
24-31 Temperature |8 bits Lower temperature (C) at which to
lower limit declare an alarm
[2] Reserved
[3] Reserved
[4] Reserved
[5] Reserved
[6] Reserved
[7] Reserved
Message Router
Class Attribute List
Table 27: Class Attribute List
Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
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Table 27: Class Attribute List (Continued)
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Attribute ID  Access Rule Name Data Type Description
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device

Common Service

Table 28: Common Service

Service Code Class Instance Service Name Description
0x0E ° . Get_Attribute_Sin |Read instance attribute of the
gle class

Connection Manager

Class Attribute List
Table 29: Class Attribute List

Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device

Common Service

Table 30: Common Service

Service Code Class Instance Service Name Description

0x0E ) . Get_Attribute_Sin |Read instance attribute of the
gle class

0x10 ° Set_Attribute_Sin |Write instance attribute of the
gle class

Ox4E ) . Forward_Close |[close connection

0x54 ° Forward_Open open connection
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Class Attribute List
Table 31: Class Attribute List

Attribute ID  Access Rule Name Data Type Description
1 Get Revision UINT (16) Object revision
2 Get Max Instance |UINT (16) Maximum instance number of the
object
3 Get Number of UINT (16) Number of object instances cur-
instances rently created in the class
6 Get Max ID of UINT (16) The Maximum class attribute ID
class attributes number which is implemented in
the device
7 Get Max ID of UINT (16) The Maximum instance attribute
instance attri- ID number which is implemented
butes in the device

Instance Attribute List

Table 32: Instance Attribute List

Attribute ID  Access Rule Name Data Type Description

1 Get Device Up UDINT (32) Time since device was powered
Time up

2 Get Total port UDINT (32) Number of physical ports
count

3 Get System Firm- |Short String Human readable representation of
ware Version System Firmware Version

4 Get Power Source [INT (16) Status of switch power source

5 Get Port Mask Size |UINT (16) Number of DWORDs in port array

attributes

8 Get Global Port Array of DWORD |Ports Link Status

Link Status

Common Service

Table 33: Common Service

Service Code Class Instance Service Name Description
0x01 o Get_Attributes_All|Returns multiple attributes in
numerical order.
0x0E ) . Get_Attribute_Sin |Read instance attribute of the
gle class
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| Introduction

PROFINET is the standard for industrial networking in automation. It connects devices, sys-
tems, and cells, facilitating faster, safer, less costly and higher quality manufacturing. It easily
integrates existing systems and equipment while bringing the richness of Ethernet down to the
factory floor.
PROFINET 10 recognizes three classes of devices:
B 1O devices
An 1/O device is a distributed I/O field device that is connected to one or more 1/O control-
lers via PROFINET 1/O. The I/O device is the provider of input data and the consumer of
output data.
B |O controllers
This is typically the programmable logic controller (PLC) on which the automation pro-
gram runs. The 1/O controller provides output data to the configured 1/O-devices in its role
as provider and is the consumer of input data of /O devices.
B |O supervisors

This can be a programming device, personal computer (PC), or human machine inter-
face (HMI) device for commissioning or diagnostic purposes.

1O Supervisor 10 Controller
PC/SCADA PLC

—_—

Ethernet

IO Device
(Field device)

Figure 65: PROFINET IO
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Configuring PROFINET

STRIAL PROTOCOLS

| Enable PROFINET I/O

The PROFINET function default is enabled in the PROFINET project series. It can be config-
ured manually in the Web page. To access this page, click Management > PROFINET >
PROFINET Settings.

£ PROFINET Settings ~

State (® Enabled (O Disabled
Turn on PROFINET will enable LLDP.

Figure 66: PROFINET Settings

Table 34: PROFINET Settings

Item Description

State Click Disabled or Enabled to set the PROFINET state.
Apply Click Apply to save the values and update the screen.
MRP

Media Redundancy Protocol (MRP) is a data network protocol standardized by the Interna-
tional Electrotechnical Commission as IEC 62439-2. It allows rings of Ethernet switches to
overcome any single failure with recovery time much faster than achievable with Spanning
Tree Protocol. It is suitable to most Industrial Ethernet applications.

MRP Settings

The MRP Settings page allows you to configure the status (enabled or disabled) of the func-
tion.

To access this page, click L2 Switching > MRP > MRP Settings.

£ MRP Settings ~

State (® Enabled () Disabled

Figure 67: L2 Switching > MRP > MRP Settings
The following table describes the items in the previous figure.

Table 35: L2 Switching > MRP > MRP Settings

Iltem Description

State Select Enabled or Disabled to set up the MRP Settings function.
Apply Click Apply to save the values and update the screen.
MRP Groups

The MRP Groups page allows you to select the function and role for each ring ID and its con-
nected ports.
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To access this page, click L2 Switching > MRP > MRP Groups.

STRIAL PROTOCOLS

# MRP Groups Settings -~
Role Port 1 Port 2
WRC  [+] Pott  [+] Port1 -

Figure 68: L2 Switching > Loopback Detection > Global Settings

The following table describes the items in the previous figure.

Table 36: L2 Switching > Loopback Detection > Global Settings

Iltem Description

Role Click the drop-down menu to select the MRP role.

Port 1 Click the drop-down menu to define the port designation.
Port 2 Click the drop-down menu to define the port designation.
Add Click Add to save the values and update the screen.

The ensuing table for Information settings is informational only: Ring ID, Role, Port 1, Port 2
and Delete (click to delete the desired Ring ID).

B Default enable:
— LLDP
— VLAN 0 transparent mode
*MRP is disabled by default

| PROFINET Cyclic I/O Data

The B&B PROFINET switch provides PROFINET 1/O cyclic data and includes the following
items:

Table 37: PROFINET Cyclic I/O Data

Category Direction Byte(s) Bit Name Description
Port Status |Input 0 0 Port1 Connection 0 is not connected, 1 is connected
1 Port2 Connection 0 is not connected, 1 is connected
2 Port3 Connection 0 is not connected, 1 is connected
3 Port4 Connection 0 is not connected, 1 is connected
4 Port5 Connection 0 is not connected, 1 is connected
5 Porté Connection 0 is not connected, 1 is connected
6 Port7 Connection 0 is not connected, 1 is connected
7 Port8 Connection 0 is not connected, 1 is connected
1 0 Port9 Connection 0 is not connected, 1 is connected
1 Port10 Connection |0 is not connected, 1 is connected
2 Port11 Connection 0 is not connected, 1 is connected
3 Port12 Connection |0 is not connected, 1 is connected
4 Port13 Connection |0 is not connected, 1 is connected
5 Port14 Connection |0 is not connected, 1 is connected
6 Port15 Connection |0 is not connected, 1 is connected
7 Port16 Connection |0 is not connected, 1 is connected
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Table 37: PROFINET Cyclic I/O Data (Continued)
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Category Direction Byte(s) Bit Name Description

Port Status |Input 2 0 Port17 Connection |0 is not connected, 1 is connected
Port18 Connection |0 is not connected, 1 is connected
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved
Reserved

w
N[O WIN|_2|O(N|OOA|D[WIN|—~

TIA Portal V13 Integration

The following steps show how to integrate the switch into a PROFINET network; -PN series
supports SIMATIC STEP 7 integration as well.

1. Create a PROFINET I/O project in TIA Portal

Create a PROFINET /O Ethernet project for deploying environment
2. GSD file installation

Import GSD file into the project
3. Add Devices and configuration

Search for and discover the switch in TIA Portal. Configure PROFINET attributes such as
IP address, device name and I/O parameters.

4. Save and load the project into the PLC
Load this project and into the PLC

5.  Watch Switch tables.
Use TIA Portal to watch switch attributes

Create a PROFINET 1/O project in TIA Portal

Create a new project.

Create new project

Project name: |Dem0\ ‘

#® Open existing project

Path: | Clwork ‘

@ Create new project Authar: [test ‘

Comment: ~

® Migrate project

Create
Figure 69: Create new project
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| GSD File Installation
Install the GSD file via Options.

STRIAL PROTOCOLS

Insert  Online | Options  Tools Window Help

ct a M 2 Y settings

Support packages

Start Automnation License Manager

%] Show reference text

Ll Global libraries ]

Figure 70: Install GSD File

Now the Ethernet Switch can be found in the Hardware catalog tree under Other field
devices > PROFINET IO > Network Components > Advantech B+B PROFINET Switch.

v (1 Distributed 1i0
v (1 Field devices
~ [ Other field devices
~ i FROFINETIO
v [ Controllers
v [ Drives
v [ Encoders
¥ ﬁ Gateway
v (g lio
v [ Ident Systems
~ i Network Components
~ [ Advantech Co., Ltd.
~ [ Advantech B+E PROFINET Switch
~ [ SE408-FN-T
v (V10
~ [ SE416-FN-T
v (V10
Figure 71: Install GSD File

Add Devices and Configuration

1. Install the GSD file via Options.

|5'? Topology view ||ﬁg,] Network view [[If Device view

% Network uu Connections | HMI cannection [+] 2 2E O} = J Network overview " Connections | 4 | >
[~] ;
w Device Type
E ¥ S71500/ET200MP station_1 S71500iET20...
PLC_1 sed16-pn-t [m} » PLC_'I. CPU 151 §—3 B
CPU 1516-3 PNL... SE416-PN-T FRO... ' ~ GSD device_1 e
Not assigned b sedlépnt SE416-PN-TF..

Figure 72: Install GSD file
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2. Draw the PROFINET IO-system between the PLC and the Switch.

STRIAL PROTOCOLS

1 10 system: PLC_1.PROFINET 10-System (100) |

PLC 1
CPU 1516-3 PNL..

sed16-pnt [ I

SE416-PN-T PRO... '
PLC_1 L.

 PLC_1_PROFINET 10-5yste . =g

Figure 73: Draw PROFINET-IO System
3. Assign a device name under the Device view.

|5'? Topology view @ Network view ‘m‘f Device view |_
5 HoE el Qs =4 | | Device overview
[l ¢ .. Module |Rack | Slot
= v sedl6pnt 0 0
Q«‘- > PO (] 0x1
&~ (] i
5
 —
- !
—
= change device
virite 10-Device name to Micro Memory Card 5
Start device tool... -
X an Ctrl+X |
55| Copy carl+C 5
[T Paste Crrlev
% Delete Del
Rename F2
& Go to topology view
B Go to netwark view
Compile »
Download to device 3
& Goonline Cirl+k
G Cirl+M
<1 Curl+D e
<[ —i— < [ [>
E“Pmperﬁes Hii.‘.lrlfu ;j"ﬂ Diagnostics |
| General g" Cross-references " Con
lQI\LI\QI‘ Show all messages [= ShifteF1
/g Properties Alt+Enter
! Path Deseriptit | Export module lsbeling strips |Gow 2 Errors  Warnings  Time

Figure 74: Assign Device Name
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n PROFINET

Configured PROFINET device

PROFINETdevice name: | se416-pnt [~
Device fype: | SE416-PN-TFPROFINETIIO ]

Online access

Type ofthe PGIFC interiace: | B_FNiE [~
PGIPCinterface: [l intel(R) FROI1000 MT Desktop Adapter 1@
= Device filter

[ Only show devices of the same type
[T] ©nly show devices with bad parameter settings

[T] ©nly show devices without names

Accessible devices in the network:

IP address MAC address Device type PROFINET device name Status
192.168.1.1 00-D0-C9-F5-0E-9E  SE416-PN-T — 1 No device name assigned
[7] Flash LED
[] [ 2]
[ Update list | [ Assignname |

Online status information:

@  searchcompleted. 1 of 1 devices were found.

[<] i []

Close

Figure 75: Assign Device Name

4. Add Port Link Status to the Module.

==
‘opology view ||EE,] Network view ||—[|'f Device view | Options [ajg]
= T
Device overview O o
=3 (-9
~ =
= 2| .. Module Rack Slot i | Catalog E
E v sedlgpnt 0 0 [=earch> 2
» PNHO 0 0x1 | & Fieer g
| Port Link Status_1 o 1 » [l Head module E
~ [ Module
~ [ Port Link Status g
[l Fort Link Status o
=

Figure 76: Add Port Link Status
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|Save and Load the Project into the PLC

Compile and Download to device.

STRIAL PROTOCOLS

Project  Edit | Wiew Insert Online Options

ke N
K a Open chject
Ky Undo Insert "Port Link Status™  Ctrl+Z
Redo Crrl+Y
| De
;‘1{ Cut Crrl+x
rak ;
3 "_ig Copy Crl+C
_"g Facste Crrl+v
¥ | % Delete Del
Rename F2
Selectall Curl+A
-
2 Eind and replace Ctrl+F
g Properties Alt+Enter

Figure 77: Compile Project

Insert | Online | Options Tools Window Help

ct a & Goonline Crrl+K
—{ & Extended go online...

m‘i‘ Go offline Ctrl+M

Simulaticn ]

Stop runtimelsimulation

m Download to device Ctrl+L
Extended download to device...

- Snepshot of the monitor values

configura =
. Upload from device (software)
2 diagno B Urload fram device (software)
Upload device as new station (hardware and software)...
m blocks : )
. Backup from online device
logy obje
3l source HMI Device maintenance »
Is B2 Accessible devices.. ctrl+U
ta types
?:3 [N startcru Ctrl+Shift+E
and force
Stop CPU Ctrl+5hift+Q
| new wat [E -
ce table | M Online & diagnostics Ctri+D

Figure 78: Download to Device
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1. Add a new watch table to Project tree > Devices.

TRIAL PROTOCOLS

Project tree m 4

Devices
FHOQ@

¥ |] Demo

"b' Add new device

Eg'h Devices & networks

~ [ PLC_1 [CPU 1516-3 PN/DP]

[I§ pevice configuration
g Online & diagnostics
!—:El Program blocks
E Technolegy objects
External source files
% FLC tags
E_ﬂ PLC data types
:al Watch and force tables

“5 Add new watch table
F

(v vvvwvw~

;| Force table
E Online backups

-

[
¥ Traces

-

B8 Frogram info

» [§il Device proxydata
Figure 79: Download to Device

2. Drag /O (Port_Link_Status_1 > Details View) into Watch_table 1.

Project tree m 4
Devices
B = FF o # HZ T
i Name Address Display format Monitor value Modify value 7
» [3 PLCtags 1 g %l0.0 Bool
v [ PLC data types 2 %101 Baol
= [z Watch and force tables 3 %I0.2 Bool
B Add new watch table 4 %10.3 Baol
E&l Force able 5 %I04 Bool
=l watch table_1 6 %I0.5 Bool
+ [ Online backups 7 %I0.6 Bool
b [ Traces B %I0.7 Bool
B4 Program info b B %€1.0 gool
» [i, Device proxydata 10 %11 Baol
4 PLC alarms 11 %I1.2 Bool
2 Text lists 12 %113 Bool
+ [ Local modules 13 %I1.4 Bool
~ [ Distributed 110 14 %115 Baol
= [ PROFINETIO-System (100): PNIE_1 15 %I1.6 Bool
~ [ se416pnt 16 %I1.7 Bool
I} pevice configuration 17 <Add news
4/ Online & diagnestics
W se416pna
[l Port Link status_1 :
b [gf Common dats E
v ‘ Details view
Name Type Address
MY Device configuration ~
| Online & diagnastics ‘ General U" Cross-references " Compile ‘
«m %00 N e —
Sul %I0.1
[ R 1 [path Description Goto 2
<@ %I0.3
Tl %I04
<@ %I0.5
lam %I0.6
u} %I0.7
ol %I1.0
u} %11
ol %I1.2
[ %I1.3 v

Figure 80: Watch Table
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3.  Monitor via the Online menu.
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Project Edit View Insert | Online |Options Tools Window Help

_%'F 3 H Save project & Goonline Crrl+k
& Extended go online...
&Y Go offline Crl+M
Devices Simulation »
HQ@ Stop runtimelsimulation
Crrl+L
» [d PLCtags
» [ PLC data types

1

|52 Watch and force
B Add new wat =
F=| Force table -
Watch table_|
» [ Online backups
» ':0." Traces

I Upload from device (software

Upload device as new station (hardware and software)...

Backup from online device

B¢ Program info HMI Device maintenance 4
= : 7 =
» L Device proxydat 85 accessible devices... Cerl+U
A PLCalarms -
S I startcrU Cerl+Shift+E
] Text lists :
rt—! I8 stop cPU Crrl+5hifieQ
¢ | Local modules

1

[ Distributed o | * I

= = -
~ [L] PROFINETIQS 1 Manitar now

> [ sed16pn;  Modify »
)| DEV_ICE g g Expanded Made
4/ onling
0 sca16] %] Online Ctrl+D
Figure 81: Monitoring
_ ARB [N
i Name Address Display format Monitor value Modify value F
1 %I0.0 Bool [=] @ mue
2 %101 Bool [ FALSE
3 %102 Bool [ FALSE
4 %03 Bool [ FALSE
5 %I0.4 Bool [ FALSE
I %05 Bool [ FALSE
7 %06 Bool [ FALSE
8 %07 Bool [ FALSE
9 %1.0 Bool [ FALSE
10 %011 Bool [ FALSE
11 %012 Bool [ FALSE
12 %013 Bool [ FALSE
13 %014 Bool [ FALSE
14 %15 Bool [ FALSE
15 %16 Bool [ FALSE
16 %17 Bool [ FALSE
17

Figure 82: Monitoring

84



BB SMARTWORX

b AD\ANTECH

MRP Partner Port
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1. Assign Partner port between PLC and Switch under Topology view.

z

EAEE R

PLC 1
CPU 1516-3 PNL.

sed16-pn-t

Yits

SE416-PN-T PRO...

Figure 83: Topology View

|5'? Topology view | Network view

Topology

o Fortinterc:
ﬂ Device
Sl

T

s

2. Return to Network view. MRP parameters will display in the PN/IE_1 Properties.

an

% MNetwork| 1} Connections [H connectior

PLC 1
CPU 1516-3 PN

sed16-pret i
Highlight 10 system: )
PLC_1 PROFINET 10-System (100}
Highlight sync domain:
Sync-Domain_1

|5‘" Topology view uﬁ%ﬁ Network view @
_J Network overview

Conn
t‘i Device

¥ S71500/ET200MP station_
P FLC 1

~ GSDdevice_1
b sedibpnt

e e

» mrpdomain-2
» mrpdomain-3
b marndnmain 4

1 | PLC_1.PROFINETinterfac...
Z |sed416pnt

mrpdomain-<4  Manager {(auto) Fort_1 [X1 P1R]
mrpdemain4  Client Port 1 [X1 P1R]

Figure 84: PN/IE_1 Properties
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]
<[ [>] [100% 7 ——y— ] n ]
I 1 |g Properties |"_i.'.lnfo 1)| %l Diagnosti
J General " 10 tags || System constants || Texts
General
 Domain managemsm
b Sync domains Devices
+ MRP domains
» mrpdomain-1 10 device name IMRP domain MRP role Ring port 1 Ring port 2

Port_2 [X1 P2 R]
Port 2 [X1 P2 R]
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Verify that you are using the right power cord/adapter (DC 12-48V), please don't use the
power adapter with DC output higher than 48V, or it may damage this device.

Select the proper UTP/STP cable to construct the user network. Use unshielded twisted-pair
(UTP) or shield twisted-pair (STP) cable for RJ-45 connections that depend on the connector
type the switch equipped: 100R Category 3, 4 or 5 cable for 10Mbps connections, 100R Cate-
gory 5 cable for 100Mbps connections, or 100R Category 5e/above cable for 1000Mbps con-
nections. Also be sure that the length of any twisted-pair connection does not exceed 100
meters (328 feet).

R = replacement letter for Ohm symbol.

Diagnosing LED Indicators: To assist in identifying problems, the switch can be easily moni-
tored through panel indicators, which describe common problems the user may encounter and
where the user can find possible solutions.

If the power indicator does not light on when the power cord is plugged in, you may have a
problem with power cord. Then check for loose power connections, power losses or surges at
power outlet. If you still cannot resolve the problem, contact the local dealer for assistance.

If the LED indicators are normal and the connected cables are correct but the packets still
cannot be transmitted. Please check the user system's Ethernet devices' configuration or sta-
tus.

S [RIAL PROTOCOLS

ADVANTECH B+B SMARTWORX TECHNICAL

SUPPORT

Phone: 1-800-346-3119
(Monday - Friday, 7 a.m. to 5:30 p.m. CST)
Fax: 815-433-5109
Email: support@advantech-bb.com
Web: www.advantech-bb.com
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